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What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources 
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey
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Introducing Microsoft Office  
Home and Student 2010

Microsoft Office 2010 is a comprehensive system of programs, servers, services, and  
solutions, including a dozen desktop productivity programs that you can install on  
your computer, and four new online program versions. To meet the varying needs  
of individuals and organizations, Microsoft offers five different Office 2010 software 
suites, each consisting of a different subset of programs. The following table identifies 
the programs available in each of the software suites.

Office Home 
and Student 
2010

Office Home 
and Business 
2010

Office 
Standard 
2010

Office 
Professional 
2010

Office 
Professional 
Plus 2010

Access Yes Yes
Communicator Yes
Excel Yes Yes Yes Yes Yes
InfoPath Yes
OneNote Yes Yes Yes Yes Yes
Outlook Yes Yes Yes Outlook with 

Business 
Contact 
Manager

PowerPoint Yes Yes Yes Yes Yes
Publisher Yes Yes Yes
SharePoint 
Workspace

Yes

Word Yes Yes Yes Yes Yes
Office  
Web Apps

Yes Yes

Office Standard and Office Professional Plus are available only to volume licensing 
subscribers. The Office Web Apps, which are available with Office Standard and Office 
Professional Plus, and available to the general public through Windows Live, are online 
versions of Word, Excel, PowerPoint, and OneNote. You can store documents online and 
work with them from within any Web browser window by using the Office Web Apps.



xii    Introducing Microsoft Office Home and Student 2010

This book provides instructional material for the following programs, which together 
form the Office Home and Student 2010 software suite:

●	 Microsoft Word 2010  A word-processing program with which you can quickly 
and efficiently author and format documents.

●	 Microsoft Excel 2010  A spreadsheet program with which you can analyze, 
communicate, and manage information.

●	 Microsoft PowerPoint 2010  A program with which you can develop and present 
dynamic, professional-looking presentations.

●	 Microsoft OneNote 2010  A digital notebook program in which you can collect 
and organize many types of electronic information, and quickly locate information 
when you need it.

The information in this book applies to these programs in all the software suites. If you 
have a software suite other than Office Home and Student, or if you installed one or more 
of these programs independently of a software suite, this is the right book for you.

Certification
Desktop computing proficiency is increasingly important in today’s business world. When 
screening, hiring, and training employees, more employers are relying on the objectivity 
and consistency of technology certification to ensure the competence of their workforce. 
As an employee or job seeker, you can use technology certification to prove that you 
already have the skills you need to succeed. A Microsoft Office Specialist (MOS) is an indi
vidual who has demonstrated worldwide skill standards through a certification exam in 
one or more of the Office 2010 programs, including Microsoft Access, Excel, Outlook, 
PowerPoint, or Word. To learn more about the MOS program, visit the Microsoft Office 
Specialist Certification page at go.microsoft.com/fwlink/?LinkId=193884.

Let’s Get Started!
Office 2010 includes new features, new functionality, and an easy-to-use interface 
intended to streamline your computing experience and make it easier to learn new 
programs. We’re excited to bring you this glimpse into the inner workings of selected 
features in the core Office programs. We’ll start with the basics and work into the most 
interesting and necessary features of each program. If you are an experienced Office 
user, you can skim Chapter 1, “Explore Office 2010,” skip Chapter 2, “Work with Files,” 
and jump right into the program-specific chapters.
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Modifying the Display of the Ribbon
The goal of the Microsoft Office 2010 working environment is to make working with 
Office files—including Microsoft Word documents, Excel workbooks, PowerPoint pre-
sentations, Outlook e-mail messages, and Access databases—as intuitive as possible. You 
work with an Office file and its contents by giving commands to the program in which 
the document is open. All Office 2010 programs organize commands on a horizontal bar 
called the ribbon, which appears across the top of each program window whether or not 
there is an active document.

Ribbon tabs Ribbon groups

A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some ap-
pear in galleries in which you can choose from among multiple options. Some groups 
have related dialog boxes or task panes that contain additional commands.

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this section, we discuss the general appearance 
of the ribbon, things that affect its appearance, and ways of locating commands that 
aren’t visible on compact views of the ribbon.

See Also  For detailed information about the ribbon, see “Working in the Program 
Environment” in Chapter 1, “Explore Office 2010.”

Tip  Some older commands no longer appear on the ribbon but are still available in the 
program. You can make these commands available by adding them to the Quick Access 
Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 1, 
“Explore Office 2010.”
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Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the  
ribbon in the form of a large button, a small button, a small labeled button, or a list  
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons  
on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review 
tab of the Word program window are spread out and you’re able to see more of the 
commands available in each group.

Drop-down list Large buttonSmall labeled button

The Review tab of the Word program window at 1024 pixels wide.

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons are hidden under one button that represents the group. Click the group but-
ton to display a list of the commands available in that group.

Group button Small unlabeled buttons

The Review tab of the Word program window at 675 pixels wide.
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When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

Scroll arrow

The Review tab of the Word program window at 340 pixels wide.

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which  
depends on these three factors:

●	 The width of the program window  Maximizing the program window provides the 
most space for ribbon elements. You can resize the program window by clicking 
the button in its upper-right corner or by dragging the border of a non-maximized 
window.

On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen. 

●	 Your screen resolution  Screen resolution is the amount of information your screen 
displays, expressed as pixels wide by pixels high. The greater the screen resolution, 
the greater the amount of information that will fit on one screen. Your screen res
olution options are dependent on your monitor. At the time of writing, possible screen 
resolutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the 
greater the number of pixels wide (the first number), the greater the number of 
buttons that can be shown on the ribbon, and the larger those buttons can be.
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On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel. 

You set the resolution by dragging the pointer on the slider.

●	 The density of your screen display  You might not be aware that you can change 
the magnification of everything that appears on your screen by changing the screen  
magnification setting in Windows. Setting your screen magnification to 125% makes  
text and user interface elements larger on screen. This increases the legibility of 
information, but it means that less information fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel.

See Also  For more information about display settings, refer to Windows 7 Step by Step 
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP 
Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.
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You can choose one of the standard display magnification options or create another by  
setting a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and 
screen elements to 120 dpi. You can choose a custom setting of up to 500 percent 
magnification, or 480 dpi, in the Custom DPI Setting dialog box.

You can choose a magnification of up to 200 percent from the lists or choose  
a greater magnification by dragging the ruler from left to right.
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Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1024 × 768, at 100% magnification, and with the default text size (96 dpi). If any 
of your settings are different, the ribbon on your screen might not look the same as the 
one shown in the book. For example, you might see more or fewer buttons in each of 
the groups, the buttons you see might be represented by larger or smaller icons than 
those shown, or the group might be represented by a button that you click to display  
the group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

●	 On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

●	 On the Page Layout tab, in the Page Setup group, click the Breaks button and 
then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display an  
image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
not appear as shown in the book, you can easily adapt the steps to locate the command. 
First, click the specified tab. Then locate the specified group. If a group has been col-
lapsed into a group list or group button, click the list or button to display the group’s com
mands. Finally, look for a button that features the same icon in a larger or smaller size 
than that shown in the book. If necessary, point to buttons in the group to display their 
names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.



	     xix

Features and Conventions  
of This Book

This book has been designed to lead you step by step through tasks you’re likely to 
want to perform in Microsoft Word 2010, Excel 2010, PowerPoint 2010, and OneNote 
2010. These four programs are available as part of the Microsoft Office Home and 
Student 2010 software suite.

See Also  This book, Microsoft Office Home and Student 2010 Step by Step, includes a 
selection of instructional content for each program in the Office Home and Student 2010 
software suite. For more complete coverage of the features of Word, Excel, or PowerPoint, 
refer to the corresponding program-specific Step by Step book.

Each chapter of this book includes self-contained topics that teach you about specific 
program features. Most topics conclude with a step-by-step exercise in which you prac-
tice using the program. The following features of this book will help you locate specific 
information:

●	 Detailed table of contents  Scan the listing of the topics and sidebars within each 
chapter.

●	 Chapter thumb tabs  Easily locate the beginning of each chapter by looking at the 
colored blocks on the odd-numbered pages.

●	 Topic-specific running heads  Within a chapter, quickly locate a topic by looking 
at the running heads at the top of odd-numbered pages.

●	 Glossary  Look up the meaning of a word or the definition of a concept.

●	 Detailed index  Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information. These 
conventions are listed in the table on the next page.
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Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates the prac-

tice files that you will use when working through the exercise. It also 
indicates any requirements you should attend to or actions you should 
take before beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides instructions 
for saving and closing open files or programs before moving on to an-
other topic. It also suggests ways to reverse any changes you made to 
your computer while working through the exercise.

1
2

Blue numbered steps guide you through hands-on exercises in each 
topic.

1

2

Black numbered steps guide you through procedures in sidebars and 
expository text.

See Also This paragraph directs you to more information about a topic in this 
book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and provides 
guidance for fixing it.

Tip This paragraph provides a helpful hint or shortcut that makes working 
through a task easier.

Important This paragraph points out information that you need to know to 
complete a procedure.

Keyboard Shortcut This paragraph provides information about an available keyboard 
shortcut for the preceding task.

Key combinations A plus sign (+) between two keys means that you must press those 
keys at the same time. For example, “Press Ctrl+B” means that you 
should hold down the Ctrl key while you press the B key.
Pictures of buttons appear in the margin the first time the button is 
used in an exercise.

Interface objects In exercises that begin with SET UP information, the names of program 
elements, such as buttons, commands, windows, and dialog boxes, 
as well as files, folders, or text that you interact with in the steps, are 
shown in bold black type.

User input In exercises that begin with SET UP information, text that you should 
type is shown in bold blue type.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?Linkid=192152

Display the detail page in your Web browser and follow the instructions for downloading 
the files.

Important  The Office Home and Student 2010 software suite is not available from this Web 
page. You should purchase and install that software suite before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 1:  
Explore Office 2010

None

Chapter 2: 
Work with Files

Prices_start.docx
Procedures_start.docx
Rules_start.docx

Chapter 3:  
Edit and Proofread Text

Bamboo_start.docx
Brochure_start.docx
Letter_start.docx
Orientation_start.docx
RulesRegulations_start.docx

Chapter 4:  
Change the Look of Text

AgendaA_start.docx
AgendaB_start.docx
Information_start.docx
OrientationDraft_start.docx
RulesDraft_start.docx

Chapter 5:  
Organize Information in 
Columns and Tables

ConsultationA_start.docx
ConsultationB_start.docx
RepairCosts_start.docx
RoomPlanner_start.docx
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Chapter File
Chapter 6:  
Add Simple Graphic  
Elements

Announcement_start.docx
Authors_start.docx
Flyer_start.docx
Joan.jpg
Joyce.jpg
MarbleFloor.jpg
OTSI-Logo.png

Chapter 7:  
Preview, Print, and  
Distribute Documents

InfoSheetA_start.docx
InfoSheetB_start.docx
InfoSheetC_start.docx
OfficeInfo_start.docx

Chapter 8: 
Set Up a Workbook

ExceptionSummary_start.xlsx
ExceptionTracking_start.xlsx
MisroutedPackages_start.xlsx
PackageCounts_start.xlsx
RouteVolume_start.xlsx

Chapter 9: 
Work with Data  
and Excel Tables

2010Q1ShipmentsByCategory_start.xlsx
AverageDeliveries_start.xlsx
DriverSortTimes_start.xlsx
Series_start.xlsx
ServiceLevels_start.xlsx

Chapter 10: 
Perform Calculations  
on Data

ConveyerBid_start.xlsx 
ITExpenses_start.xlsx
PackagingCosts_start.xlsx
VehicleMiles_start.xlsx

Chapter 11: 
Change Workbook 
Appearance

CallCenter_start.xlsx
Dashboard_start.xlsx
ExecutiveSearch_start.xlsx
HourlyExceptions_start.xlsx
HourlyTracking_start.xlsx
Phone.jpg
Texture.jpg
VehicleMileSummary_start.xlsx
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Chapter File
Chapter 12: 
Focus on Specific Data  
by Using Filters

Credit_start.xlsx
ForFollowUp_start.xlsx
PackageExceptions_start.xlsx

Chapter 13:  
Work with Slides

Projects.pptx
ServiceA_start.pptx
ServiceB_start.pptx
ServiceC_start.pptx
ServiceD_start.pptx
ServiceOrientation.docx

Chapter 14:  
Work with Slide Text

BuyingTripsB_start.pptx
BuyingTripsC_start.pptx
CommunityServiceA_start.pptx
CommunityServiceB_start.pptx
CommunityServiceC_start.pptx

Chapter 15:  
Format Slides

BusinessTravelA_start.pptx
BusinessTravelB_start.pptx
ColorDesign_start.pptx
CompanyMeetingA_start.pptx
CompanyMeetingB_start.pptx
LandscapingA_start.pptx

Chapter 16: 
Add Simple Visual 
Enhancements

Agastache.jpg
JournalingA_start.pptx
JournalingB_start.pptx
Penstemon.jpg
WaterConsumption.xlsx
WaterSavingA_start.pptx
WaterSavingB_start.pptx
WaterSavingC_start.pptx

Chapter 17:  
Review and Deliver 
Presentations

Harmony_start.pptx
Meeting_start.pptx
SavingWater_start.pptx
ServiceOrientationA_start.pptx
ServiceOrientationB_start.pptx
YinYang.png
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Chapter File
Chapter 18: 
Explore OneNote 2010

None

Chapter 19: 
Create and Configure 
Notebooks

None

Chapter 20: 
Create and Organize Notes

SBS Content Entry folder
ADatumLogo.png
Cabo.jpg
California_Poppy.jpg
Desert.jpg
Landscaping.pptx

Your Companion eBook
The eBook edition of this book allows you to:

●	 Search the full text

●	 Print

●	 Copy and paste

To download your eBook, please see the instruction page at the back of this book.
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Getting Help
Every effort has been made to ensure the accuracy of this book. If you do experience  
problems, please consult the sources listed in the following sections.

Getting Help with This Book
If your question or issue concerns the content of this book or its practice files, please 
first consult the book’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=192152

This page provides information about known errors and corrections to the book. If 
you do not find your answer on the errata page, send your question or comment to 
Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with Office 2010
If your question is about one of the programs in the Microsoft Office Home and 
Student 2010 software suite, and not about the content of this book, your first recourse is 
the Help system for the individual program. This system is a combination of tools and 
files stored on your computer when you installed the software suite or program and, if 
your computer is connected to the Internet, information available from the Microsoft 
Office Online Web site. You can find Help information in the following ways:

●	 To find out about an item on the screen, you can display a ScreenTip. For example, 
to display a ScreenTip for a button, point to the button without clicking it. The 
ScreenTip gives the button’s name, the associated keyboard shortcut if there is 
one, and a description of what the button does when you click it.

●	 In the program window, you can click the Help button (a question mark in a blue 
circle) at the right end of the ribbon to display the program-specific Help window. 

●	 After opening a dialog box, you can click the Help button (also a question mark) 
at the right end of the dialog box title bar to display the program-specific Help 
window. Sometimes, topics related to the functions of that dialog box are already 
identified in the window.
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To practice getting help, you can work through the following exercise.

SET UP  You don’t need any practice files to complete this exercise. Start Word, and 
then follow the steps.

	 1.	 At the right end of the ribbon, click the Microsoft Word Help button.

The Word Help window opens.

You can change the size of the font in the window by clicking the Change Font Size button on 
the toolbar.

If you are connected to the Internet, clicking any of the buttons below the Microsoft  
Office banner (Products, Support, Images, and Templates) takes you to a corre-
sponding page of the Office Web site.
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	 2.	 Below the bulleted list under Browse Word 2010 support, click see all.

The window changes to display a list of Help topics.

	 3.	 In the list of topics, click Activating Word.

Word Help displays a list of topics related to activating Microsoft Office programs. 
You can click any topic to display the corresponding information.

	 4.	 On the toolbar, click the Show Table of Contents button.

The window expands to accommodate two panes. The Table Of Contents pane  
appears on the left. Like the table of contents in a book, it is organized in sections. 

If you’re connected to the Internet, Word displays sections, topics, and training 
available from the Office Online Web site as well as those stored on your computer.

Clicking any section (represented by a book icon) displays that section’s topics (represented by 
Help icons).
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	 5.	 In the Table of Contents pane, click a few sections and topics. Then click the Back 
and Forward buttons to move among the topics you have already viewed.

	 6.	 At the right end of the Table of Contents title bar, click the Close button.

	 7.	 At the top of the Word Help window, click the Type words to search for box, 
type saving, and then press the Enter key.

The Word Help window displays topics related to the word you typed.

Next and Back buttons appear, making it easier to search for the topic you want.
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	 8.	 In the results list, click the Recover earlier versions of a file in Office 2010 topic.

The selected topic appears in the Word Help window.

	 9.	 Below the title at the top of the topic, click Show All.

Word displays any information that has been collapsed under a heading and 
changes the Show All button to Hide All. You can jump to related information  
by clicking hyperlinks identified by blue text.

Tip  You can click the Print button on the toolbar to print a topic. Only the displayed 
information is printed.

CLEAN UP  Click the Close button at the right end of the Word Help window.

More Information
If your question is about an Office 2010 program or another Microsoft software product 
and you cannot find the answer in the product’s Help system, please search the appro-
priate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/
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	 2	 Work with Files
In this chapter, you will learn how to

✔	 Create and save files.
✔	 Open, move around in, and close files.
✔	 View files in different ways.

When working in Microsoft Word, Excel, or PowerPoint, you save content in individual files. 
In each program, you can save files as different types depending on each file’s purpose. 
The standard files are Word documents, Excel workbooks, and PowerPoint presentations. 
Regardless of the program or file type, you use similar techniques for creating, saving, 
moving around in, and viewing files in each program.

When working in OneNote, content is saved in individual files representing pages that are 
part of a notebook structure. OneNote creates the files for you and saves your changes 
as you work, so you don’t need to. However, you use some of the same techniques for 
moving around in and viewing files as you do in other Microsoft Office 2010 programs.

In this chapter, you’ll practice working with files in Word, using techniques that are com-
mon to working in files created in Word, Excel, or PowerPoint. First you’ll create and save 
a document and then save an existing document in a different location. Then you’ll open 
an existing document, move around in it, and close it. Finally, you’ll explore various ways 
of viewing file content.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter02 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.
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Creating and Saving Files
When you start Word, Excel, or PowerPoint without opening a specific file, the program 
displays a blank document, workbook, or presentation in which you can start entering 
content. A blinking cursor (in the form of a vertical line) in the text pane or worksheet 
cell shows where the next character you type will appear.

When an Office 2010 program is running, you can create a new file from the New page 
of the Backstage view, which you display by clicking the File tab on the ribbon.

From the New page, you can create a document based on a preformatted template.

Tip  More documents may be added to those available from Microsoft Office Online, so the 
templates available on your New page might be different from those shown here.

The documents listed on the New page are based on templates, which are sets of for-
mats that have been saved in such a way that you can use them as a pattern for new 
documents. For example, in Word 2010 the icons in the top section of the Available 
Templates gallery are:

●	 Blank document  Clicking this icon opens a document formatted with the standard 
settings. The document contains no content.

Tip  The standard Word document settings are based on a template named Normal, 
which is installed on your computer as part of the Office installation. You can make 
changes to the Normal template but it is not customary or advisable to do so.
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●	 Blog post  Clicking this icon opens a document containing the basic elements of a 
blog post in a document window. The document window includes additional func-
tionality enabling you to easily post directly to an existing blog site from within 
Word.

●	 Recent templates  Clicking this icon displays a page on which you can select from 
the most recent templates you have used.

Tip  Clicking the Back button or the Home button takes you back to the New page.

●	 Sample templates  Clicking this icon displays a page on which you can select from 
sample documents that come with Word.

●	 My templates  Clicking this icon displays a dialog box in which you can select a 
template you have created as the basis for a new document.

●	 New from existing  Clicking this icon displays a dialog box in which you can select 
an existing document as the basis for a new document.

The icons in the Office.com Templates section represent categories of common types of 
files for the program you’re working in. Depending on how many templates are available 
in a category, the icon might be a folder. Regardless, clicking one of these icons displays 
more templates that are available for download from the Microsoft Office Online Web 
site. You can also search for specific file types by entering the type you want in the Search 
Office.com For Templates box and clicking the Start Searching button.

See Also  For information about document templates, refer to Microsoft Word 2010 Step by 
Step by Joyce Cox and Joan Lambert (Microsoft Press, 2010).

When you find a template you might want to use as the basis for your new file, clicking 
its icon displays a preview of that file in the right pane. You can then click the Create but-
ton in the right pane to create the file.

Tip  Double-clicking an icon creates that type of file without first displaying it in the preview 
pane.

Each file you create from the New page of the Backstage view is temporary until you 
save it. To save a document, workbook, or presentation for the first time, you click 
the Save button on the Quick Access Toolbar or click Save in the Backstage view. Either 
action displays the Save As dialog box, where you can assign a name and storage loca-
tion to the file.
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By default, the Save As dialog box displays the contents of your Documents library.

Troubleshooting  This graphic shows the Save As dialog box as it appears when Word is run
ning on Windows 7. If you are using a different version of the Windows operating system,  
your dialog box will look different but the way you work in it will be similar.

If you want to save the file in a folder other than the one shown in the Address bar at 
the top of the dialog box, you can click the arrow or chevrons in the Address bar or click 
locations in the Navigation pane on the left to display the folder you want. If you want 
to create a folder in which to store the file, you can click the New Folder button on the 
toolbar.

If you want to save a file in a format other than the one shown in the Save As Type box, 
click the Save As Type arrow and then, in the Save As Type list, click the file format you 
want.
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After you save a file the first time, you can save subsequent changes by clicking the Save 
button. The new version of the file then overwrites the previous version.

Keyboard Shortcut  Press Ctrl+S to save the current document.

Tip  Windows 7 automatically retains previous file versions. To view previous versions of a file 
on a computer running Windows 7, right-click the file in Windows Explorer, and then click 
Restore Previous Versions.

If you want to keep both the new version and the previous version, click Save As in the 
Backstage view, and then save the new version with a different name in the same loca-
tion or with the same name in a different location. (You can’t store two files of the same 
type with the same name in the same folder.)

Tip  By default, each program periodically saves the file you’re working on in case the program 
stops responding or you lose electrical power. To adjust the frequency at which the program 
saves the file, display the Backstage view, click Options, click the Save tab in the left pane 
of the Options dialog box, and specify the period of time in the box to the right of the Save 
AutoRecover Information Every check box. Then click OK.

In this exercise, you’ll work with files in Word by using techniques that are common to 
all Office 2010 programs. You’ll create a blank document, enter text, and save the docu-
ment in a folder that you create.

SET UP  You don’t need any practice files to complete this exercise. Start Word, and 
then follow the steps.

	 1.	 On the ribbon, click the File tab to display the Backstage view. Then in the left 
pane of the Backstage view, click New.

	 2.	 On the New page, double-click Blank document.

Word creates a blank document temporarily called Document2 and displays it in its 
own program window in Print Layout view. Document1 is still open, but its window 
is hidden by the Document2 window.

Tip  Word created Document1 when you started the program.

See Also  For information about switching between open windows, see “Viewing Files in 
Different Ways” later in this chapter.

	 3.	 With the cursor at the beginning of the new document, type Parks Appreciation 
Day, and then press the Enter key.

The text appears in the new document.
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	 4.	 Type the following sentence (including the period):

Help beautify our city by participating in the annual cleanup of Log Park, 
Swamp Creek Park, and Linkwood Park. This is a lot of fun! Volunteers  
receive a free T-shirt and barbeque lunch. Bring your own gardening tools 
and gloves.

Notice that you did not need to press Enter when the cursor reached the right  
margin because the text automatically continued on the next line.

You press Enter at the end of each paragraph; the Word Wrap feature takes care of wrapping 
each line.

Tip  If a red or green wavy line appears under a word or phrase, Word is flagging a 
possible error in spelling or grammar. For now, ignore any errors.

	 5.	 Press Enter, and then type the following sentence (including the period):

The Service Committee is coordinating groups to participate in this  
event. If you are interested in spending time outdoors with your family  
and friends while improving the quality of our parks, contact Paul Shen at 
paul@treyresearch.net.

	 6.	 On the Quick Access Toolbar, click the Save button.

The Save As dialog box opens, displaying the contents of your Documents library. 
In the File Name box, Word suggests the first words in the document as a possible 
name.

	 7.	 Navigate to your Chapter02 practice file folder.
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	 8.	 On the dialog box’s toolbar, click the New folder button, type My New Documents 
as the name of the new folder, and press Enter. Then double-click the My New 
Documents folder.

	 9.	 In the File name box, click anywhere in Parks Appreciation Day to select it, and 
then replace this name by typing My Announcement.

Important  Each type of file is identified by a specific file name extension. For exam
ple, the extension .docx identifies documents created in Word 2010 or Word 2007 that 
don’t contain macros. Windows 7 does not display these extensions by default, and you 
don’t need to type them in the Save As dialog box. When you save a file, Word automatic
ally adds whatever extension is associated with the type of file selected in the Save As 
Type box.

	 10.	 Click Save.

The Save As dialog box closes, Word saves the My Announcement document in the 
My New Documents folder, and the name of the document, My Announcement, 
appears on the program window’s title bar.

	 11.	 Display the Backstage view, and then click Save As.

The Save As dialog box opens, displaying the contents of the My New Documents 
folder, because that is the last folder you worked with.

	 12.	 In the Address bar of the Save As dialog box, to the left of My New Documents, 
click Chapter02.

The dialog box now displays the contents of the Chapter02 practice file folder, 
which is the folder that contains the My New Documents folder.

See Also  For information about working with the file properties that appear at the bot
tom of the Save As dialog box, see “Preparing Documents for Electronic Distribution”  
in Chapter 7, “Preview, Print, and Distribute Documents.”

	 13.	 Click Save.

Word saves the My Announcement document in the Chapter02 practice file folder. 
You now have two versions of the document saved with the same name but in dif-
ferent folders.

CLEAN UP  At the right end of the title bar, click the Close button (the X) to close the 
My Announcement document. Leave Document1 open for use in the next exercise.
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File Compatibility with Earlier Versions of Office Programs

The Office 2010 programs use file formats based on a programming language called 
extended markup language, or more commonly, XML. These file formats, called the 
Microsoft Office Open XML Formats, were introduced with Microsoft Office 2007.

The Office Open XML formats provide the following benefits:

●	 File size is smaller because files are compressed when saved, decreasing the 
amount of disk space needed to store the file, and the amount of bandwidth 
needed to send files in e-mail, over a network, or across the Internet.

●	 Recovering at least some of the content of damaged files is possible because 
XML files can be opened in a text program such as Notepad.

●	 Security is greater because the standard file formats cannot contain macros, 
and personal data can be detected and removed from the file. (Word 2010 and 
Word 2007 provide a different file format—.docm—for documents that  
contain macros.)

Each Office 2010 program offers a selection of file formats intended to provide 
specific benefits. The file formats and file name extensions for Word 2010 docu-
ments include the following:

●	 Word Document (.docx)

●	 Word Macro-Enabled Document (.docm)

●	 Word Template (.dotx)

●	 Word Macro-Enabled Template (.dotm)

●	 Word XML Document (.xml)

The file formats and file name extensions for Excel 2010 documents include the 
following:

●	 Excel Workbook (.xlsx)

●	 Excel Macro-Enabled Workbook (.xlsm)

●	 Excel Binary Workbook (.xlsb)

●	 Excel Template (.xltx)

●	 Excel Macro-Enabled Template (.xltm)

●	 Excel Add-In (.xlam)
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The file formats and file name extensions for PowerPoint 2010 documents include 
the following:

●	 PowerPoint Presentation (.pptx)

●	 PowerPoint Macro-Enabled Presentation (.pptm)

●	 PowerPoint Template (.potx)

●	 PowerPoint Macro-Enabled Template (.potm)

●	 PowerPoint Show (.ppsx)

●	 PowerPoint Macro-Enabled Show (.ppsm)

●	 PowerPoint Add-In (.ppam)

●	 PowerPoint XML Presentation (.xml)

●	 PowerPoint Picture Presentation (.pptx)

Other non–program specific file types, such as text files, Web pages, PDF files, and 
XPS files, are available from the Save As dialog box of each program.

Tip  OneNote notebooks are stored in folders. For information about the OneNote 
file formats, see “Navigating in the OneNote Program Window” in Chapter 18, 
“Explore OneNote 2010.”

You can open a file created with Office 2003, Office XP, Office 2000, or Office 97 
in an Office 2010 program, but new features will not be available. The file name 
appears in the title bar with [Compatibility Mode] to its right. You can work in 
Compatibility mode, or you can convert the document to the current file format  
by displaying the Info page of the Backstage view and clicking the Convert button 
in the Compatibility Mode section. You can also click Save As in the Backstage view 
to save a copy of the file in the current format.

If you work with people who are using Office 2003, Office XP, Office 2000, or 
Office 97, you can save your documents in a format that they will be able to open 
and use by choosing the corresponding 97-2003 file format in the Save As Type 
list, or they can download the Microsoft Office Compatibility Pack for Word, Excel, 
and PowerPoint File Formats from the Microsoft Download Center (located at 
download.microsoft.com) so that they can open current Office files in their version 
of Office.
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Opening, Moving Around in, and Closing Files
If a program isn’t already running, you can start the program and simultaneously open 
an existing file by double-clicking the file in Windows Explorer. While a program is run-
ning, you can open an existing document from the Backstage view. If you have recently 
worked on the document you want to open, you can display the Recent page and simply 
click the document you want in the list. If the document is not available on the Recent 
page, clicking Open in the left pane displays the Open dialog box.

The Open dialog box, displaying the contents of a recently used folder.

By default, the Open dialog box displays your Documents library, with a combined view 
of your My Documents folder and the Public Documents folder. If you display the dialog 
box again in the same Word session, it displays the contents of the folder from which 
you last opened a file. To display the contents of a different folder, you can use the stan-
dard Windows techniques described in “Creating and Saving Files” earlier in this chapter. 
After you locate the document you want to work with, you can open it by clicking its file 
name and then clicking Open in the lower-right corner of the dialog box, or by simply 
double-clicking the file name.

Tip  Clicking a file name and then clicking the Open arrow (not the button) displays a list of 
alternative ways in which you can open the file. To look through the file without making any 
inadvertent changes, you can open it as read-only, or you can open a separate copy of the file. 
After a computer crash or similar incident, you can open the file and attempt to repair any 
damage. You can also display the file in other versions and formats.
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If you open a document that is too long to fit entirely on the screen, you can bring 
off-screen content into view without changing the location of the cursor by using the 
vertical scroll bar in the following ways:

●	 Click the scroll arrows to move up or down by one line.

●	 Click above or below the scroll box to move up or down by the height of one 
window.

●	 Drag the scroll box on the scroll bar to display the part of the document corre-
sponding to the location of the scroll box. For example, dragging the scroll box  
to the middle of the scroll bar displays the middle of the document.

If the document is too wide to fit on the screen, Word displays a horizontal scroll bar 
that you can use in similar ways to move from side to side.

You can also move around in a document by moving the cursor. To place the cursor in a 
specific location, you simply click there. To move the cursor one page backward or for-
ward, you click the Previous Page and Next Page buttons below the vertical scroll bar. 
You can also press a keyboard key to move the cursor. For example, pressing the Home 
key moves the cursor to the left end of a line.

Tip  The location of the cursor is displayed on the status bar. You can also display its location 
by page, section, line, and column, and in inches from the top of the page. SImply select the 
option you want from the status bar shortcut menu.

The following table lists ways to use your keyboard to move the cursor.

Cursor movement Key or keyboard shortcut
Left one character Left Arrow
Right one character Right Arrow
Down one line Down Arrow
Up one line Up Arrow
Left one word Ctrl+Left Arrow
Right one word Ctrl+Right Arrow
To the beginning of the current line Home
To the end of the current line End
To the beginning of the document Ctrl+Home
To the end of the document Ctrl+End
To the beginning of the previous page Ctrl+Page Up
To the beginning of the next page Ctrl+Page Down
Up one screen Page Up
Down one screen Page Down
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In a long document, you might want to move quickly among elements of a certain type; 
for example, from graphic to graphic. Clicking the Select Browse Object button at the 
bottom of the vertical scroll bar displays a gallery of browsing options, such as Browse By 
Page and Browse By Graphic. (These options are also available on the Go To tab of the 
Find And Replace dialog box, which you display by clicking the Find arrow in the Editing 
group of the Home tab and then clicking Go To.) You can also display the Navigation 
task pane and move from heading to heading or page to page.

Keyboard Shortcut  Press Ctrl+G to display the Go To tab of the Find And Replace dialog box.

See Also  For information about using the Navigation task pane to search for specific content 
in a document, see “Finding and Replacing Text” in Chapter 3, “Edit and Proofread Text.”

If more than one document is open, you can close the active document without exiting 
Word by clicking the Close button at the right end of the title bar. If only one document is 
open, clicking the Close button closes the document and also exits Word. If you want to 
close that document but leave Word running, you must click Close in the Backstage view.

In this exercise, you’ll work with files in Word by using techniques that are common to all 
Office 2010 programs. You’ll open an existing document, save a copy of the document, 
and explore various ways of moving around in it. Then you’ll close the document.

SET UP  You need the Rules_start document located in your Chapter02 practice file 
folder to complete this exercise. Continue from the previous exercise or exit and 
restart Word so that Document1 is the only open document. Then follow the steps.

	 1.	 Click the File tab to display the Backstage view, and then click Open.

The Open dialog box opens, showing the contents of the folder you used for your 
previous open or save action.

	 2.	 Navigate to the location in which you saved the practice files for this book, and 
open the Chapter02 folder.

	 3.	 Click the Rules_start document, and then click Open.

The Rules_start document opens in the Word program window.
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An existing document displayed in Print Layout view.

Troubleshooting  The appearance of buttons and groups on the ribbon changes 
depending on the width of the program window. For information about changing  
the appearance of the ribbon to match our screen images, see “Modifying the Display  
of the Ribbon” at the beginning of this book.

	 4.	 Display the Backstage view, and in the left pane, click Save As. In the Save As 
dialog box, change the file name to Rules, and then click Save.

Now you can experiment with the document without fear of overwriting the 
original.

	 5.	 In the second line of the document title, click at the end of the paragraph to 
position the cursor.

	 6.	 Press the Home key to move the cursor to the beginning of the line.

	 7.	 Press the Right Arrow key six times to move the cursor to the beginning of the 
word and in the heading.
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	 8.	 Press the End key to move the cursor to the end of the line.

	 9.	 Press Ctrl+End to move the cursor to the end of the document.

	 10.	 Press Ctrl+Home to move the cursor to the beginning of the document.

	 11.	 At the bottom of the vertical scroll bar, click the Next Page button.

	 12.	 Click above the scroll box to change the view of the document by the height of 
one window.

	 13.	 Drag the scroll box to the top of the scroll bar.

The beginning of the document comes into view. Note that the location of the  
cursor has not changed—just the view of the document.

	 14.	 Click to the left of the first row of the title to place the cursor at the top of the 
document, and then near the bottom of the vertical scroll bar, click the Select 
Browse Object button.

A gallery of browsing choices opens.

The Select Browse Object gallery.

	 15.	 Move the pointer over the buttons representing the objects among which you can 
browse.

As you point to each button, the name of the browsing option appears at the top 
of the gallery.

	 16.	 Click the Browse by Page button.

The cursor moves from the beginning of page 1 to the beginning of page 2.

	 17.	 Click the View tab, and then in the Show group, select the Navigation Pane 
check box.

The Navigation task pane opens on the left side of the screen, displaying an outline 
of the headings in the document. The heading of the section containing the cursor 
is highlighted.



	 Opening, Moving Around in, and Closing Files    51

From the Navigation task pane, you can move from heading to heading or from page to page.

	 18.	 In the Navigation task pane, click the Landscaping heading.

Word scrolls the document and moves the cursor to the selected heading.

	 19.	 In the Navigation task pane, click the Browse the pages in your document tab 
(the one with the icon of four small pages). Then scroll through the thumbnails in 
the task pane, and click page 5.

	 20.	 At the right end of the Navigation task pane title bar, click the Close button.

	 21.	 At the right end of the program window title bar, click the Close button.

The Rules document closes, and Document1 becomes the active document.

	 22.	 Display the Backstage view, and then click Close.

Document1 closes, leaving Word running.

Troubleshooting  In step 22, if you click the Close button at the right end of the title bar 
instead of clicking Close in the Backstage view, you’ll close the open Word document 
and exit the Word program. To continue working, start Word again.

CLEAN UP  If you’re continuing directly to the next exercise, leave Word running.
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Viewing Files in Different Ways
In each program, you can display the content of a file in a variety of views, each suited 
to a specific purpose. You switch the view by clicking the buttons in the Document Views 
group on the View tab, or those on the View Shortcuts toolbar in the lower-right corner 
of the program window. The views in each program are specific to that program’s files.

Word 2010 includes the following views:

●	 Print Layout view  This view displays a document on the screen the way it will look 
when printed. You can see page layout elements such as margins, page breaks, 
headers and footers, and watermarks.

●	 Full Screen Reading view  This view displays as much of the content of the docu-
ment as will fit on the screen at a size that is appropriate for reading. In this view, 
the ribbon is replaced by one toolbar at the top of the screen with buttons for sav-
ing and printing the document, accessing references and other tools, highlighting 
text, and making comments. You can move from page to page and adjust the view by 
selecting options from the View Options menu. You can edit the document only 
if you turn on the Allow Typing option on this menu, and you can switch views 
only by clicking the Close button to return to the previous view.

●	 Web Layout view  This view displays the document the way it will look when 
viewed in a Web browser. You can see backgrounds and other effects. You can  
also see how text wraps to fit the window and how graphics are positioned.

●	 Outline view  This view displays the structure of a document as nested levels of 
headings and body text, and provides tools for viewing and changing its hierarchy.

●	 Draft view  This view displays the content of a document with a simplified layout so 
that you can type and edit quickly. You can’t see page layout elements.

See Also  For information about Web Layout view and Outline view, refer to Microsoft 
Word 2010 Step by Step by Joyce Cox and Joan Lambert (Microsoft Press, 2010).

Excel 2010 includes the following views:

●	 Normal view  This view displays the worksheet with column and row headers.

●	 Page Layout view  This view displays the worksheet on the screen the way it will 
look when printed, including page layout elements.

●	 Page Break Preview view  This view displays only the portion of the worksheet that 
contains content, and any page breaks. You can drag page breaks in this view to 
move them.
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PowerPoint 2010 includes the following views:

●	 Normal view  This view displays individual slides with active content objects such 
as text containers, and a separate pane into which you can enter notes.

●	 Slide Sorter view  This view displays all the slides in a presentation. You can apply 
formatting to individual slides and to groups of slides, but you can’t edit the slide 
content.

●	 Notes Page view  This view displays each slide and its accompanying notes as they 
will look when printed in the Notes Page print layout.

●	 Reading view  This view displays individual slides as they will appear on the screen, 
without active content objects. In this view, the ribbon is hidden. You can move 
from page to page and adjust the view by selecting options from a menu on the 
status bar. You can’t edit slide content in this view.

See Also  For information about OneNote 2010 notebook views, see Chapter 18, “Explore 
OneNote 2010.”

When you want to focus on the layout of a document, worksheet, or slide, you can 
display rulers and gridlines to help you position and align elements. Simply select the 
corresponding check boxes in the Show group on the View tab. You can also adjust the 
magnification of the document by using the tools available in the Zoom group on the 
View tab, or the Zoom button or Zoom slider at the right end of the status bar. Clicking 
the Zoom button in either location displays a dialog box where you can select or type a 
percentage; or you can drag the Zoom slider to the left or right or click the Zoom Out or 
Zoom In button on either side of the slider to change the percentage incrementally.

You’re not limited to working with one file at a time. You can easily switch between open 
files, and you can display more than one program window simultaneously. If you want to 
work with different parts of a document, you can open the document in a second win-
dow and display both, or you can split a window into two panes and scroll through each 
pane independently by using options in the Window group on the View tab.

Not represented on the View tab is a feature that can be invaluable when you are fine-
tuning the layout of a document. Clicking the Show/Hide ¶ button in the Paragraph 
group on the Home tab turns the display of nonprinting and hidden characters on and 
off. Nonprinting characters, such as tabs and paragraph marks, control the layout of your 
document, and hidden characters provide the structure for behind-the-scenes processes, 
such as indexing. You can control the display of these characters for each window.

Tip  You can hide any text by selecting it, clicking the Font dialog box launcher, selecting the 
Hidden check box, and clicking OK. When the Show/Hide ¶ button is turned on, hidden text is 
visible and is identified in the document by a dotted underline.
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In this exercise, you’ll work with files in Word by using techniques that are common to 
all Office 2010 programs. First you’ll explore various ways that you can customize Print 
Layout view to make the work of developing documents more efficient. You’ll turn white 
space on and off, zoom in and out, display the rulers and Navigation task pane, and view 
nonprinting characters and text. Then you’ll switch to other views, noticing the differ-
ences so that you have an idea of which one is most appropriate for which task. Finally, 
you’ll switch between open documents and view documents in more than one window 
at the same time.

SET UP  You need the Procedures_start and Prices_start documents located in your 
Chapter02 practice file folder to complete this exercise. Open the Procedures_start 
document and save it as Procedures. Then follow the steps.

	 1.	 In Print Layout view, scroll through the document.

As you can see, on all pages but the first, the printed document will have the title 
in the header at the top of the page, the page number in the right margin, and the 
date in the footer at the bottom of each page.

See Also  For information about headers and footers, refer to Microsoft Word 2010 Step 
by Step by Joyce Cox and Joan Lambert (Microsoft Press, 2010).

	 2.	 Point to the gap between any two pages, and when the pointer changes to two 
opposing arrows, double-click the mouse button. Then scroll through the docu-
ment again.

The white space at the top and bottom of each page and the gray space between 
pages are now hidden, as are the header and footer.

Hiding white space between pages makes it quicker to scroll through a long document and 
easier to compare the content on two pages.

	 3.	 Restore the white space by pointing to the line that separates one page from the 
next and double-clicking the mouse button.
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	 4.	 Press Ctrl+Home to move to the top of the document, and then near the right end 
of the status bar, click the Zoom button.

The Zoom dialog box opens.

You can click a preset zoom percentage or specify your own.

	 5.	 Click Many pages. Then click the monitor button, click the second page thumbnail 
in the top row, and click OK.

The magnification changes so that you can see two pages side by side.

You can now scroll through the document two pages at a time.
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	 6.	 At the bottom of the vertical scroll bar, click the Next Page button to display the 
third and fourth pages of the document.

	 7.	 On the View tab, click the Zoom button. Then in the Zoom dialog box, click 75%, 
and click OK.

Notice that the Zoom percentage and slider position are adjusted to reflect the 
new setting.

	 8.	 On the status bar, at the left end of the Zoom slider, click the Zoom Out button 
two times.

As you click the button, the Zoom percentage decreases and the slider moves to 
the left.

	 9.	 At the right end of the Zoom slider, click the Zoom In button until the magnifica-
tion is 100 percent.

	 10.	 On the View tab, in the Show group, select the Ruler check box.

Horizontal and vertical rulers appear above and to the left of the page. On the  
rulers, the content area of the page is white and the margins are blue.

	 11.	 On the Home tab, in the Paragraph group, click the Show/Hide ¶ button.

Nonprinting characters such as spaces, tabs, and paragraph marks are now visible.

You can display the nonprinting characters that control the layout of the content.

	 12.	 On the View Shortcuts toolbar, click the Full Screen Reading button.

Word displays the document in a format that’s easy to read.
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You can’t edit content in Full Screen Reading view unless you set the view options to Allow 
Typing.

	 13.	 In the lower-right corner of the window, click the Forward button.

You can now read the next two screens of information.

	 14.	 To the right of the screen indicator at the top of the window, click the Previous 
Screen button.

	 15.	 Point to each button on the toolbar at the top of the window to display its 
ScreenTip. Then in the upper-right corner, click the Close button to return to 
Print Layout view.

	 16.	 Press Ctrl+Home. Then on the View Shortcuts toolbar, click the Web Layout 
button, and scroll through the document.

In a Web browser, the text column will fill the window and there will be no page 
breaks.

	 17.	 Press Ctrl+Home, and then on the View Shortcuts toolbar, click the Outline 
button.

Word displays the document’s hierarchical structure, and the Outlining tab appears 
on the ribbon.
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	 18.	 On the Outlining tab, in the Outline Tools group, click the Show Level arrow, 
and in the list, click Level 2.

The document collapses to display only the Level 1 and Level 2 headings.

You can control the level of detail shown in the document’s hierarchy.

	 19.	 On the View Shortcuts toolbar, click the Draft button, and then scroll through 
the document.

You can see the basic content of the document without any extraneous elements, 
such as margins and headers and footers. The active area on the ruler indicates the 
width of the text column, dotted lines indicate page breaks, and scrolling is quick 
and easy.

	 20.	 Display the Backstage view, click Open, and then in the Open dialog box display-
ing the contents of your Chapter02 practice file folder, double-click Prices_start.

The Prices_start document opens in Print Layout view in its own window. Notice 
that the telephone number in the body of the memo has a dotted underline, which 
indicates that it is formatted as hidden.

	 21.	 Save the Prices_start document as Prices so that you can work with it without 
overwriting the original.

	 22.	 On the Home tab, in the Paragraph group, click the active Show/Hide ¶ button 
to turn it off.

The telephone number is no longer visible.
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	 23.	 On the View tab, in the Window group, click the Switch Windows button, and 
then in the list of open documents, click Procedures.

The Procedures document is displayed in Draft view with nonprinting characters 
and hidden text turned on.

	 24.	 On the View tab, in the Window group, click the Arrange All button.

The open windows are sized and stacked one above the other. Each window has  
a ribbon, so you can work with each document independently.

You can display more than one window at the same time.

Tip  The ribbons in each window take up a lot of screen space. To see more of each 
document, you can click the Minimize The Ribbon button to hide all but the tab names.

	 25.	 At the right end of the Document1 window title bar, click the Close button. Then 
in either open window, click the Arrange All button again.

Word resizes the open windows to occupy the available space.

	 26.	 At the right end of the Prices window title bar, click the Maximize button.

The window expands to fill the screen.

	 27.	 On the View tab, in the Show group, clear the Ruler check box.

CLEAN UP  Close the Procedures and Prices documents.
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Key Points
●	 You create new documents, workbooks, presentations, and notebooks from the 

New page of the Backstage view. When creating documents, workbooks, and  
presentations, you can choose a blank template or a template that includes preset 
formatting and content placeholders.

●	 When you save a file, you specify its name, location, and file format in the Save As 
dialog box. Each program offers several file formats.

●	 The cursor indicates the location in which text will be inserted when you type. It’s 
easy to move the cursor by clicking in the text or by pressing keys and keyboard 
shortcuts.

●	 You can view a file in a variety of ways, depending on your needs as you create the 
file and on the purpose for which you are creating it.
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	15	 Format Slides
In this chapter, you will learn how to

✔	 Apply themes.
✔	 Use different color and font schemes.
✔	 Change the slide background.
✔	 Change the look of placeholders.
✔	 Change the alignment, spacing, size, and look of text.

An overall consistent look, punctuated by variations that add weight exactly where it is 
needed, can enhance the likelihood that your message will be well received and 
absorbed by your intended audience. To make your Microsoft PowerPoint 2010 presen-
tations visually appealing, you can add enhancements to the presentation as a whole or 
to individual slides.

In this chapter, you’ll apply a theme to a presentation and then change the theme’s color 
and font schemes. You’ll add color and shading to the background of slides and to the 
background of placeholders. Finally, you’ll change the look of specific text elements.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter15 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Applying Themes
When you create a presentation based on a template or a ready-made design, the  
presentation includes a theme—a combination of colors, fonts, formatting, graphics, 
and other elements that gives the presentation a coherent look. Even a presentation  
developed from scratch has a theme; the Office theme is applied by default. This  
theme consists of a white background, a very basic set of colors, and the Calibri font.
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If you want to change the theme applied to a presentation, you can choose one from 
the Themes gallery. By using the Live Preview feature, you can easily try different effects 
until you find the one you want.

See Also  For information about creating your own themes, refer to Microsoft PowerPoint 
2010 Step by Step, by Joyce Cox and Joan Lambert (Microsoft Press, 2010).

In this exercise, you’ll change the theme applied to one presentation that was created 
from scratch and to another that was created from a template.

SET UP  You need the Landscaping_start and CompanyMeetingA_start presentations 
located in your Chapter15 practice file folder to complete this exercise. Open the 
presentations, and save them as Landscaping and CompanyMeetingA, respectively. 
Then follow the steps.

	 1.	 With the Landscaping presentation active, on the Design tab, in the Themes 
group, click the More button.

The Themes gallery appears, displaying all the available themes.

The theme attached to this presentation is identified in the This Presentation area.

	 2.	 Point to each theme thumbnail in turn to see a live preview of what the presentation 
will look like with that theme applied.

Notice that the themes are organized alphabetically and that their names appear in 
ScreenTips when you point to them.
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	 3.	 Click the Austin thumbnail to apply that theme to the entire presentation.

	 4.	 Click the Home tab, and then on slide 1, click the presentation’s title.

Instead of a white background with black text in the Calibri font, the presentation 
now has a green background design with title text in the Century Gothic font.

Most built-in themes have a distinctive title slide design that is modified for all the other  
slide layouts.

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.

	 5.	 On the View tab, in the Window group, click the Switch Windows button, and 
click CompanyMeetingA to switch to that presentation.

This presentation already has a theme applied to it.

	 6.	 Display the Themes gallery, and then click the Urban thumbnail.

The background of the presentation now has dark blue and teal accents, and the 
text is in blue Trebuchet and black Georgia.

CLEAN UP  Save and close the CompanyMeetingA and LandscapingA presentations.
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Using Different Color and Font Schemes
Every presentation you create with PowerPoint 2010, even a blank one, has a set of 
colors, called a color scheme, associated with its theme. A color scheme consists of 12 
complementary colors designed to be used for the following elements of a slide:

●	 Text /Background  Use these four colors for dark text on a light background or 
light text on a dark background.

●	 Accent 1 through Accent 6  Use these six colors for objects other than text.

●	 Hyperlink  Use this color to draw attention to hyperlinks.

●	 Followed Hyperlink  Use this color to indicate visited hyperlinks.

When you click color buttons such as the Font Color button in the Font group on the 
Home tab, the color palette displays 10 of the 12 colors with light to dark gradients. 
(The two background colors are not represented in these palettes.)

Understanding color schemes can help you create professional-looking presentations that 
use an appealing balance of color. You’re not limited to using the colors in a presentation’s 
color scheme, but because they have been selected by professional designers and are based 
on good design principles, using them ensures that your slides will be pleasing to the eye.

See Also  For information about how scheme colors are allocated, refer to Microsoft 
PowerPoint 2010 Step by Step, by Joyce Cox and Joan Lambert (Microsoft Press, 2010). 
For information about using non-scheme colors, see the sidebar “Non–Color Scheme  
Colors” later in this chapter.

To view the color schemes you can apply to a presentation, you display the Colors gallery, 
which has Live Preview capabilities. When you find a color scheme you like, you simply 
click it to change the color scheme of all the slides in the presentation.

Tip  To apply a color scheme only to a selected slide, right-click the scheme and then click 
Apply To Selected Slides

In addition to changing the color scheme, you can change the font scheme, which pro-
vides two complementary fonts for each theme. The Fonts gallery lists the combinations 
in alphabetical order by theme. In each combination, the top font (called the heading 
font) is used for slides titles, and the bottom font (called the body font) is used for other 
slide text.

If none of the color schemes is exactly what you’re looking for, you can create your own 
by clicking Create New Theme Colors at the bottom of the Colors gallery and assembling 
colors in the Create New Theme Colors dialog box. You can also create a custom font 
scheme by clicking Create New Theme Fonts at the bottom of the Fonts gallery and then 
specifying the font combination you want in the Create New Theme Fonts dialog box. 
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After you save either type of custom scheme, you can apply it to one or all of the slides 
in a presentation.

When you apply a different color scheme or font scheme to a presentation, your changes 
are stored with the presentation and do not affect the underlying theme.

Tip  Also associated with each theme is an effects scheme. This scheme ensures that the 
shapes in the presentation have a consistent look. Clicking the Effects button in the Themes 
group of the Design tab displays a gallery of effect combinations to choose from.

In this exercise, you’ll apply a different color scheme to a presentation, create your own 
scheme, change the color scheme of one slide, and then apply a different font scheme.

SET UP  You need the CompanyMeetingB_start presentation located in your Chapter15 
practice file folder to complete this exercise. Open the CompanyMeetingB_start pres
entation, and save it as CompanyMeetingB. Then follow the steps.

	 1.	 On the Design tab, in the Themes group, click the Colors button.

The Colors gallery appears.

The color schemes show 8 of the 12 available colors.
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	 2.	 In the gallery, point to a few color schemes, and watch the Live Preview effect on 
the active slide.

	 3.	 Click Essential to apply that color scheme to the presentation instead of the 
default color scheme of the Urban theme.

Notice that the theme retains all of its other characteristics, such as the fonts and 
background graphic; only the colors change.

	 4.	 With slide 1 displayed, in the Themes group, click the Colors button.

	 5.	 Right-click the Solstice color scheme, and then click Apply to Selected Slides.

PowerPoint applies the Solstice color scheme to only the title slide, changing its 
main background color from red to dark brown, but retaining the gold accent 
color.

	 6.	 On the Design tab, in the Themes group, click the Fonts button.

The Fonts gallery appears.

Two fonts are assigned to each theme.
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	 7.	 In the Fonts gallery, point to a few font schemes to display live previews of their 
effects on the active slide.

	 8.	 Click Newsprint.

PowerPoint applies that font scheme to the presentation instead of the default font 
scheme of the Urban theme.

The title slide with the new font scheme.

CLEAN UP  Save the CompanyMeetingB presentation, and then close it.

Changing the Slide Background
In PowerPoint, you can customize the background of a slide by adding a solid color, a 
color gradient, a texture, or even a picture.

A color gradient is a visual effect in which a solid color gradually changes from light to 
dark or dark to light. PowerPoint offers several gradient patterns, each with variations. 
You can also choose a preset arrangement of colors from professionally designed back-
grounds in which different colors gradually merge.
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If you want something fancier than a solid color or a gradient, you can give the slide 
background a texture. PowerPoint comes with several built-in textures that you can eas-
ily apply to the background of slides. If none of these meets your needs, you might want 
to use a picture of a textured surface. For a dramatic effect, you can also incorporate 
an image or design of your own, although these are best reserved for small areas of the 
slide rather than the entire background.

In this exercise, you’ll shade the background of one slide. Then you’ll apply a textured 
background to all the slides in the presentation.

SET UP  You need the ColorDesign_start presentation located in your Chapter15 
practice file folder to complete this exercise. Open the ColorDesign_start presenta
tion, and save it as ColorDesign. Then follow the steps.

	 1.	 On the Design tab, in the Background group, click the Background Styles 
button.

The Background Styles gallery appears.

The gallery shows four solid colors and two gradients in each of four colors taken from  
the theme’s color scheme.

	 2.	 In the gallery, point to each thumbnail in turn to see a live preview of its effects.
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	 3.	 Click the third thumbnail in the second row (Style 7).

Instantly, the background of all the slides in the presentation change to a blue 
gradient.

	 4.	 Click the Background Styles button again, and then at the bottom of the gallery, 
click Format Background.

The Format Background dialog box opens.

The Fill page shows the settings that control the gradient.

	 5.	 Click the Type arrow to display the list of options, and then click Rectangular.

Behind the dialog box, the active slide changes to reflect this setting.

	 6.	 Display the Direction list, and click the rightmost thumbnail (From Top Left 
Corner).
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	 7.	 In the Gradient stops area, drag the middle handle on the slider (Stop 2 of 3) to 
the right until the Position setting is 80%.

Behind the dialog box, you can see that 80 percent of the slide is now a lighter 
shade, with the gradient to dark occupying only about 20 percent.

	 8.	 Display the Color list, and then under Theme Colors, click the third box in the 
purple column (Purple, Accent 4, Lighter 40%).

	 9.	 Click Close.

PowerPoint applies the shaded background to the current slide only.

The title slide has a two-tone gradient that gives a raised effect.

	 10.	 Click the Background Styles button again, and then click Format Background.

	 11.	 In the Format Background dialog box, click Picture or texture fill.

The active slide shows a live preview of the default texture.

	 12.	 Display the Texture gallery, and then click Purple mesh.
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	 13.	 Click the Apply to All button, and then click Close.

PowerPoint applies the textured background to all the slides in the presentation.

	 14.	 In the Themes group, click the More button.

The Themes gallery appears.

At the top of the gallery is a thumbnail reflecting the formatting you have applied to this 
presentation.

CLEAN UP  Save the ColorDesign presentation, and then close it.

Changing the Look of Placeholders
For a consistent look, you won’t usually want to change the formatting of a presenta-
tion’s placeholders. However, when you want to draw attention to an entire slide or an 
element of a slide, you can do so effectively by making specific placeholders stand out. 
You might also want to format text boxes that you have drawn manually on a slide.

See Also  For information about drawing text boxes, see “Adding Text Boxes” in Chapter 14, 
“Work with Slide Text.”
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When you format a placeholder or a text box, you are essentially formatting a shape. 
You have the following options:

●	 Fill the background with a color, gradient, texture, pattern, or picture.

●	 Change the color and style of the shape’s outline.

●	 Apply a style such as a shadow, reflection, or glow.

●	 Apply a three-dimensional effect.

In this exercise, you’ll first apply a color to a text box. Then you’ll change its border and 
give it a glow effect.

SET UP  You need the BusinessTravelA_start presentation located in your Chapter15 
practice file folder to complete this exercise. Open the BusinessTravelA_start presen
tation, and save it as BusinessTravelA. Then follow the steps.

	 1.	 Display slide 5, click anywhere in the free-standing text at the bottom of the slide, 
and then click the border of the text box to select the box for manipulation.

	 2.	 On the Format contextual tab, in the Shape Styles group, click the Shape Fill 
arrow.

The Shape Fill palette appears.

Like other palettes, the Shape Fill palette reflects the theme’s colors.
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	 3.	 In the palette, point to a few colors in turn to see a live preview of its effects on the 
background of the text box.

	 4.	 Click the third shade in the orange column (Orange, Accent 1, Lighter 40%).

The background of the text box is now a medium orange color.

	 5.	 Click the Shape Fill arrow again, and then below the palette, point to Gradient.

The Gradient gallery appears.

This gallery offers light and dark versions of gradients in different directions.

	 6.	 Under Dark Variations, click the second thumbnail in the third row (Linear Up).

	 7.	 In the Shape Styles group, click the Shape Outline arrow, and under Standard 
Colors, click the Dark Red box.
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	 8.	 Click the Shape Outline arrow again. Then below the palette, point to Weight, 
and in the list, click 3 pt.

Tip  The abbreviation pt stands for point. A point is a unit of measurement used in the 
design and publishing industries. There are 72 points to the inch.

	 9.	 In the Shape Styles group, click the Shape Effects button.

A list of all the types of effects you can apply to the text box appears.

Many possible effects are available with a couple of mouse clicks.

	 10.	 In turn, display the options for each type, and point to a few to see their live 
previews.

	 11.	 When you have finished exploring, point to Glow, and then click the first thumbnail 
in the last row (Orange, 18 pt glow, Accent color 1).

	 12.	 Click away from the text box to release the selection.

The text box is less likely to be overlooked now. 
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You can easily set off text boxes and placeholders with combinations of color, borders,  
and effects.

CLEAN UP  Save the BusinessTravelA presentation, and then close it.

Changing the Alignment, Spacing, Size, 
and Look of Text

In most PowerPoint templates, text appears as either a slide title or a bulleted list. The 
alignment and spacing of the text are controlled by the design built into the template. 
You can override these settings, which are collectively called paragraph formatting. Click 
anywhere in the paragraph, and then do the following:

●	 Lists  Click the Bullets arrow to display a gallery of alternative built-in bullet symbols. 
You can click None to remove bullet formatting and create an ordinary paragraph. 
To switch to a numbered list, click the Numbering arrow, and then click the number-
ing style you want.
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●	 Alignment  Click one of the following alignment buttons in the Paragraph group 
on the Home tab:

❍	 Click the Align Text Left button to align text against the placeholder’s left 
edge. Left-alignment is the usual choice for paragraphs.

Keyboard Shortcut  Press Ctrl+L to left-align text.

❍	 Click the Center button to align text in the middle of the placeholder. Center-
alignment is often used for titles and headings.

Keyboard Shortcut  Press Ctrl+E to center text.

❍	 Click the Align Text Right button to align text against the placeholder’s right 
edge. Right-alignment isn’t used much for titles and paragraphs, but you 
might want to use it in text boxes.

Keyboard Shortcut  Press Ctrl+R to right-align text.

❍	 Click the Justify button to align text against both the left and right edges, 
adding space between words to fill the line. You might justify a single, non-
bulleted paragraph on a slide for a neat look.

●	 Line spacing  Click the Line Spacing button in the Paragraph group, and make a 
selection.

●	 Paragraph spacing  Open the Paragraph dialog box, either by clicking the Line 
Spacing button and then clicking Line Spacing Options at the bottom of the menu 
or by clicking the dialog box launcher in the lower-right corner of the Paragraph 
group. You can then adjust the Before and After settings for the entire paragraph.

In addition to changing the look of paragraphs, you can manipulate the look of individ-
ual words by manually applying settings that are collectively called character formatting. 
After selecting the characters you want to format, you can make changes by using the 
commands in the Font group on the Home tab, as follows:

●	 Font  Override the font specified by the font scheme by making a selection in the 
Font box.

●	 Size  Manually control the size of text either by clicking the Increase Font Size or 
Decrease Font Size button or by setting a precise size in the Font Size box.

Keyboard Shortcut  Press Ctrl+Shift+> or Ctrl+Shift+< to increase or decrease font size.
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Tip  If you turn off AutoFit so that you can manually size text, you have two ways to 
adjust the size of placeholders to fit their text: by manually dragging the handles around 
a selected placeholder, or by clicking Resize Shape To Fit Text on the Text Box page of 
the Format Shape dialog box. For information about AutoFit, see “Correcting and Sizing 
Text While Typing” in Chapter 14, “Work with Slide Text.”

●	 Style  Apply attributes such as bold, italic, underlining, and shadow and strike
through effects to selected characters.

The character style buttons.

Keyboard Shortcut  Press Ctrl+B to make text bold, Ctrl+I to make it italic, or Ctrl+U to 
underline it.

●	 Color  Change the color of the selected characters by clicking the Font Color 
arrow and then clicking the color you want in the palette.

●	 Case  Change the capitalization of the words—for example, you can change small 
letters to capital letters—by clicking the Change Case button and then clicking the 
case you want.

●	 Character spacing  Increase or decrease the space between the letters in a selec-
tion by clicking the Character Spacing button and then clicking the option you 
want. You can also click More Spacing to display the Character Spacing page of the 
Font dialog box, where you can specify spacing more precisely.

Tip  You can clear all manually applied character formatting from a selection by clicking the 
Clear All Formatting button.

To make it quick and easy to apply the most common paragraph and character format-
ting, PowerPoint displays the Mini Toolbar when you make a text selection. This toolbar 
contains the same buttons you’ll find in the Font and Paragraph groups on the Home 
tab, but they’re all in one place, adjacent to the selection. If you don’t want to apply any 
of the Mini Toolbar formats, you can simply ignore it, and it will disappear.

The Mini Toolbar.

After you have formatted the text on a slide, you might find that you want to adjust the 
way lines break to achieve a more balanced look. This is often the case with slide titles, 
but bullet points and regular text can sometimes also benefit from a few manually 
inserted line breaks. You can simply press Shift+Enter to insert a line break at the cursor. 
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This fine-tuning should wait until you have taken care of all other formatting of the slide 
element, because changing the font, size, and attributes of text can affect how it breaks.

In this exercise, you’ll experiment with changing various types of character formatting 
and paragraph formatting to achieve the look you want. You’ll also insert a few line 
breaks to balance the text on a slide.

SET UP  You need the BusinessTravelB_start presentation located in your Chapter15 
practice file folder to complete this exercise. Open the BusinessTravelB_start presen
tation, and save it as BusinessTravelB. Then follow the steps.

	 1.	 Display slide 3, and in the fourth bullet point, double-click Buyer.

The Mini Toolbar appears.

The Mini Toolbar is a shadow until you point to it.

	 2.	 Move the pointer over the Mini Toolbar to make it active, and then click the Italic 
button.

	 3.	 Display slide 4, and in the Slide pane, drag diagonally across the four bullet points 
to select them.

	 4.	 On the Home tab, in the Font group, click the Font Color arrow. Then under 
Standard Colors in the palette, click the Red box.
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	 5.	 Display slide 5, and click anywhere in the bulleted list. Then in the Editing group, 
click the Select button, and click Select All.

All the text in the placeholder is selected. The text at the bottom is not selected 
because it is in a separate text box, not in the placeholder.

	 6.	 In the Font group, click the Increase Font Size button until the setting in the Font 
Size box is 44.

Keyboard Shortcut  Press Ctrl+Shift+> to increase the font size.

Using the Increase Font Size and Decrease Font Size buttons takes the guesswork 
out of sizing text.

The first bullet point now spans the width of the placeholder.

	 7.	 In the Font group, click the Clear All Formatting button to return the font 
size to 24.

	 8.	 Display slide 9, and select both bullet points.



442    Chapter 15  Format Slides

	 9.	 In the Paragraph group, click the Bullets arrow.

The Bullets gallery appears.

You can click Bullets And Numbering at the bottom of the gallery to create custom bullets.

	 10.	 In the gallery, click None.

The bullet points are converted to regular text paragraphs.

	 11.	 With both paragraphs still selected, in the Paragraph group, click the Line 
Spacing button, and then click Line Spacing Options.

The Paragraph dialog box opens.

You can set alignment, indentation, line spacing, and paragraph spacing all in one place.
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	 12.	 In the General area, change the Alignment setting to Centered.

	 13.	 In the Spacing area, change the Before setting to 0 pt and the After settings to 
24 pt. Then change the Line Spacing setting to 1.5 lines.

	 14.	 Click OK.

	 15.	 In the first paragraph, click to the left of the word only, and press Shift+Enter 
to insert a line break. 

	 16.	 Repeat step 15 to insert another line break before the word that.

	 17.	 In the second paragraph, insert a line break before the word to and another before 
the word for.

The phrases of both paragraphs are now nicely balanced.

Line breaks can increase readability as well as the look of text on a slide.

CLEAN UP  Save the BusinessTravelB presentation, and then close it.
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Non–Color Scheme Colors
Although working with the 12 colors of a harmonious color scheme enables you to create 
presentations with a pleasing design impact, you might want to use a broader range of 
colors. You can add colors that are not part of the color scheme by selecting the element 
whose color you want to change and then choosing a standard color from the Font Color 
palette or a custom color from the wide spectrum available in the Colors dialog box.

To apply a custom color:

	 1.	 Select text on a slide, and then on the Home tab, in the Font group, click the 
Font Color arrow.

	 2.	 At the bottom of the color palette, click More Colors.
The Colors dialog box opens.

The Standard page of the Colors dialog box.

	 3.	 Click a color in the Colors spectrum, and then click OK.
You can also click the Custom tab to display a color gradient where you can select a 
color based on precise Red/Green/Blue or Hue/Saturation/Luminescence settings.

After you use a color, it becomes available on all the palettes that appear when you 
click a button that applies color—for example, the Font Color button in the Font 
group on the Home tab. The color remains on the palettes even if you change the 
theme applied to the presentation.
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Key Points
●	 Switching from one predefined theme to another is an easy way of changing the 

look of an entire presentation.

●	 You can apply a ready-made color scheme or font scheme to one or all the slides in 
a presentation, and you can create your own schemes.

●	 To dress up the background of one slide or of all the slides in a presentation, you 
can apply a solid color, a color gradient, a texture, or a picture.

●	 You can change the background, outline, and effect of specific placeholders or of 
text boxes.

●	 The formatting of paragraphs and text in a presentation can easily be changed by 
using the commands in the Focnt and Paragraph groups on the Home tab.
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aligning text, 121-122, 125-126, 438
around pictures, 169
with tab stops, 121
in tables, 155-156, 163

alignment, cell, 318
alt text in tables, 159
alternative words. See Thesaurus
And option in filters, 353
angle of text in text boxes, 394
animation, turning off, 490
annotating graphics, 393
Apply To All button (PowerPoint), 481
arguments, 296

defined, 288, 595
error codes for, 301

Arrange All button, 59
Arrange Windows dialog box (Excel), 243, 251
arranging slides, 386
arranging workbook windows, 243
arrows

button, 8, 311
filter, 348, 350-351
tracer, 301-302, 304-305

Artistic Effects button (Word), 173
aspect ratio, 595
Attach File button (OneNote), 565, 575
attachments (OneNote)

inserting, 565, 572, 575
keyboard shortcut for, 565

attributes (PowerPoint)
applying, 439
defined, 595

audio input devices, 585
audio notes (OneNote)

appearance of, 586
playing, 588
recording, 586, 587
rewinding, 588
searchability, activating, 585

Audio Search dialog box (OneNote), 586
Audio Search (OneNote), 585-586
Audio & Video Recording contextual tab 

(OneNote), 586
auditing, 595
auditing errors, 300, 595

Index

Symbols & 
Numbers
$ (dollar sign) in absolute references, 294
= (equal sign) in formulas, 286
##### error code, 301
#DIV/0! error code, 301
#NAME? error code, 301
#REF! error code, 301
#VALUE! error code, 301
[ ] (square brackets) in formulas, 289, 299
3-D borders, 128
3-D references, 604
35mm slides, 486

A
A3 Paper slide size, 486
A4 Paper slide size, 486
absolute references in formulas, 307, 595

changing to relative references, 294
dollar sign ($) in, 294

accent colors, 426
accessibility, checking, 219, 503
action button, 595
active cells, 260

in cell group, 261
in filtering, 349

active document, closing, 48
ActiveSync icon (OneNote), 550
adding values together, 286
add-ins (Word)

defined, 595
settings for, 24

adjusting shapes, 470
adjustment handles, 595
Advanced Filter dialog box, 358-359
advanced options (Word), 22
AGGREGATE function, 357-359
Align Center button (Word), 155
Align Center Right button (Word), 156, 163
Align Text Left button (PowerPoint), 438
Align Text Right button (PowerPoint), 438



author name, viewing, 220
authors (OneNote), hiding names, 548
AutoCalculate, 355, 359
AutoComplete, 257, 595
AutoCorrect

adding to, 91
customizing, 406
defined, 595
fixing spelling errors with, 88-89
limitations of, 407
modifying, 409
options, setting, 20, 89
synonyms, 416

AutoCorrect dialog box (Word), 89, 136
AutoCorrect Options button (Excel), 275
AutoExpansion (Excel), 275
AutoFill (Excel)

defined, 257, 595
entering data series, 256

AutoFill Options button (Excel), 258, 260
AutoFilter, 348
AutoFit

changing default settings , 406
reducing text size with, 411

AutoFit Options button (PowerPoint), 406, 410
AutoFormatting options, 136
automatic slide shows, 491
automating tasks with macros, 601
AutoRecover options (Word), 20, 41
AutoRepublish, 595
AutoText, 190
AVERAGE function, 287, 355
AVERAGEIF function, 297-298, 300
AVERAGEIFS function, 297, 299
averages

calculating, 297
viewing with AutoCalculate, 355, 359

B
B4 (ISO) Paper slide size, 486
B5 (ISO) Paper slide size, 486
Background Styles button (Excel), 430
Background Styles gallery (Excel), 430
backgrounds, document

appropriate use of, 176
color, applying, 176
gradients, applying, 177
overview of, 168
pictures as, applying, 179
textures, applying, 178

backgrounds, OneNote notebook, 571

backgrounds, slide
applying, 433
changing , 429, 433
colors, 426
formatting placeholder, 436

backgrounds, worksheet
deleting images from, 341-342, 344
patterns, creating, 341, 343
repeating images in, 341, 343
watermarks, 341

Backspace key, 64, 390
Backstage view

defined, 595
displaying, 6

Backstage view (OneNote), 522
Backstage view (PowerPoint), 493, 502
Backstage view (Word), 18, 38, 43, 208, 217

displaying, 48
Help page, 16
Info page, 15
New page, 16
opening documents from, 46
Print page, 16
Recent page, 16
Share page, 16

banded rows in tables, 161
Banner slide size, 486
banners, 488
bilingual dictionary, 83, 87
Bing decision engine, 270
bitmaps, 455
Black And White button (PowerPoint), 492
black and white, printing in, 492-493
black numbered steps in book, xx
black screen, removing from end of PowerPoint 

presentation, 510
blank documents, creating, 38, 41
blank OneNote pages, 551, 558
Blank Page button (Word), 183
blank pages, inserting, 183
blocking content in Word, 25
blog posts, creating, 39
blogs, 595
blue numbered steps in book, xx
Blue Pen (.05 mm) button (OneNote), 577
BMP file format, 455
Bold button (Word), 18-19, 113, 148
bolding text, 18-19, 113, 148, 311, 313, 439
book exercise format, xviii
book help, xxv
book practice files, xxi
booklets, printing, 208
Borders button (Word), 123, 128, 162
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Borders And Shading dialog box (Word), 124,  
128, 162, 181

borders, document
3-D, 128
adding, 123-124, 128
around cells, 162
page, 181

borders, PowerPoint text box, 395, 398
borders, worksheet

adding to cells, 312, 314
adding to images, 340

bound documents, previewing, 209
Breaks button (Word), 120, 125, 146, 216
breaks, column, 140, 146, 595
breaks, line

defined, 599
inserting, 120, 125, 439
keyboard shortcut for, 121

breaks, page
deleting, 214
inserting, 212
keyboard shortcut for, 215
manual, 599
soft, 212, 603

breaks, section
for columns, 140, 142
defining, 605
deleting, 214
formatting mark for, 214, 216
inserting, 214, 216
overview of, 214

brightness, adjusting, 171
Browse By Page button, 50
Browse dialog box (PowerPoint), 376
browsers. See Web browsers
browsing objects, 50
building blocks. See also header/footers; 

Quick Parts
cover pages, 183, 186
creating, 94, 194
defined, 93, 595
deleting, 185
entering in existing text, 96
gallery of, 184, 190
inserting, 94
keyboard shortcuts for, 94
overview of, 93, 168
page numbers, 183, 189, 190
properties, viewing, 185
saving, 95
text boxes, 183, 191, 196

Building Blocks Organizer, 184, 190
bullet points in slides. See also subpoints

changing into diagrams, 462
collapsing on Outline tab, 402
converting to regular text, 442

bulleted lists in documents, 69, 71, 131-133.  
See also lists

Bullets button (PowerPoint), 437, 442
Bullets button (Word), 131-132
Bullets gallery (PowerPoint), 437, 442
buttons. See also specific button names

adding to Quick Access Toolbar, 32, 244, 251
arrows on, 8, 311
default action, changing, 8
inactive, 11
moving, 32
pictures of, xx
ScreenTips for. See ScreenTips
separator between, 32-33

C
Calculate Now button (Excel), 287
calculations. See formulas
capitalization, 118-119. See also uppercase

changing, 439
searching for, 266

cascading workbook windows, 243, 251
case, 118-119

changing, 439
searching for, 266

categories. See galleries
category axes in charts, 463
category axis, 608
cell addresses, 463
cell groups, 261
Cell Margins button, 159
Cell Styles gallery, 316-317
cells, Word table

borders, 162
deleting, 153
inserting, 153
merging, 153, 155
setting width of, 159
shading, 162
splitting, 154

cells, worksheet. See also ranges
absolute references, 294, 307, 595
active, 260-261, 349
aligning, 318
borders, 312, 314
contiguous, in formulas, 290
copying, 258, 261
defined, 595
deleting, 238, 240
deleting contents/formatting of, 311
entering data in, 256, 258
filtering. See filters, Excel
finding sum of, 286
formatting, copying, 258, 260
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cells, worksheet (continued)
individual, selecting, 260
inserting, 238, 240
monitoring values in, 303, 304
moving, 238, 240
moving to, 260
noncontiguous, adding to formulas, 290
noncontiguous, formatting, 314
number formatting in, 319
pasting formulas in, 291
references, 294-295, 301, 595
shading, 312-314, 324
splitting, 606
visible, summarizing, 355, 357

Center button (PowerPoint), 438
Center button (Word), 125, 129, 143, 189, 198
Center Tab button (Word), 148
centering text, 121-122, 125, 143

with Click And Type, 121
in header/footers, 189
keyboard shortcut for, 121, 143
in tables, 155
in WordArt objects, 198

certification, xii
Change Case button (PowerPoint), 439
Change Colors button (PowerPoint), 460
Change Colors gallery (PowerPoint), 460
Change Styles button (Word), 101, 104
changes, redoing/undoing, 270, 402
chapter thumb tabs, xix
character formatting, 438. See also fonts

appropriate use of, 119
attributes, 595
bolding, 18-19, 113, 148, 311, 313, 439
case, 118
clearing, 118, 439
copying, 114, 173, 258, 260
for individual characters, 439
underlining, 113, 149

character spacing, 111
changing, 117, 439

Character Spacing list, 439
character styles, 100, 130. See also Quick Styles
characters, non-printing, 53, 56. See also 

formatting marks
Chart button (PowerPoint), 462
charts

adding to slides, 462
associated Excel worksheets, 462
category axes, 463
copying Excel data, 466
data markers, 463, 596
data points, 463, 596
data series, 256-258, 276, 463, 596

editing data, 467
entering data, 464
excluding data from, 466
hiding data, 466
legends, 463, 599
selecting for automatic updates, 468
series axes, 463
sizing, 467
switching rows/columns, 469
tick-mark labels, 463, 607
value axes, 463

Check Accessibility tool (PowerPoint), 503
Check Compatibility tool (PowerPoint), 503
checkerboard transition, 479
checking spelling, 42, 269, 272, 412, 415, 520

adding new words to dictionary, 269, 272
with AutoCorrect, 88-89
with shortcut menu, 88, 90
with Spelling and Grammar dialog box, 88
turning off, 412
typos, 63

Choose A File Or A Set Of Files To Insert dialog box 
(OneNote), 575

Choose A SmartArt Graphic dialog box 
(PowerPoint), 456

Choose Document To Insert dialog box  
(OneNote), 572

CLEAN UP paragraphs, xx
Clear All Formatting button (PowerPoint), 439, 441
Clear Formatting button (Word), 118
clearing

filters, 350-353
formatting, 118, 439
table styles, 323
validation rules, 363

Click And Type
centering text with, 121
defined, 595

clip art. See also pictures
defined, 596
free from Office.com, 448
inserting, 168, 174
inserting in notes, 569
inserting in slides, 448
saving, 174
searching for, 174, 452

Clip Art button (PowerPoint), 448, 452
Clip Art button (Word), 168, 174
Clip Art task pane (PowerPoint), 448, 452
Clipboard, 66, 72, 401, 405, 596, 600
clippings (OneNote), 579

adding to notebooks, 581
capturing, 581
displaying, 582
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options for, 580
sending to new page, 581

Close button, xxviii, 5
Close button (Excel), 467
Close button (OneNote), 557
Close button (Word), 48, 51
Close Header and Footer button (Word), 190, 216
Close Task Pane button (PowerPoint), 378
closing

Clipboard task pane, 72
dialog boxes, 12
documents, 48, 51
Help window, xxviii
programs, 5

collaborating on OneNote notebooks, 543
Collapse button (OneNote), 528, 559
Collapse Page Tabs button (OneNote), 529
Collapse Section button (PowerPoint), 385
collapsing

bullet points, 402
OneNote notebooks, 528
OneNote Page Tabs Bar, 529
OneNote subpages, 559

collating printed documents, 217, 493
Color button (Word), 171
Color gallery (Word), 171
color gradients, 429
color of pen, 509
color of Word user interface, 18
color palettes, 426
color scales, 335, 336
color schemes

applying to slides, 426
creating, 426, 444
defined, 596
viewing, 426

coloring backgrounds, 176, 426
coloring pictures, 171
Colors button (PowerPoint), 427
Colors dialog box (Excel), 321
Colors dialog box (PowerPoint), 444
Colors gallery (PowerPoint), 426
column breaks, 140, 146
column headers, 261, 356, 596
Columns button (Word), 141
Columns dialog box (Word), 144
columns, document, 139. See also table columns

applying to entire document, 141
formatting, 140
hyphenating text in, 141, 145
indenting text in, 145
justifying, 141-142
margins, 143
overview of, 140
section/column breaks in, 140, 142

separated by tab stops, 147-148, 606
spacing, changing, 144

Columns gallery, 140, 141
columns, table

deleting, 153
inserting, 153
resizing, 153
setting width of, 159

columns, worksheet
changing multiple, 237
copying, 261
deleting, 238
##### error code, 301
filtering. See filters
formatting, 312
hiding, 238-239
inserting, 237, 239
labels, and filtering, 349
labels, as range names, 283
labels, hiding, 249
moving, 261
selecting, 261
unhiding, 238
width, changing, 237
width errors, 301

combining cells, 153-155, 601
commands. See also ribbon

adding to Quick Access Toolbar, 32, 244, 251
from previous versions, adding, 7

comments
balloons for, 595
defined, 596
in worksheet ranges, 282
printing, 493

comparing worksheet values, 335-337
compatibility

checking, before distributing document, 219
with earlier versions of PowerPoint, 503
with earlier versions of Word, 44

Compatibility Mode, 45
conditional formatting, 332-338, 596
Conditional Formatting Rules Manager, 333, 335, 

337
conditional formulas, 296, 596
conditional functions, 297
conditions, setting. See validation rules
connecting shapes on slides, 478
connection points on slides, 478, 596
connectors, 596
content pane, 596
content placeholders on slides, 448, 451
content templates (OneNote), 552, 556
contextual tabs, 596
contiguous cells, adding to formulas, 290
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continuous slide shows, 490
contrast, adjusting, 171
contributors to OneNote notebooks, 548
Convert button, 45
Convert Text To Table dialog box (Word), 156
Convert To Text button (Word), 152
converting bullet points to regular text, 442
converting bulleted lists to diagrams, 462
converting Excel tables to ranges, 277
converting tables to text, 152
converting text to tables, 152, 156
converting Word documents to Web pages, 23
Copy button (PowerPoint), 401, 466
Copy button (Word), 66, 70
copying

cells, 258, 261
character formatting, 114
chart data from Excel, 466
data, 263
formatting, 114, 173, 258, 260
formulas, 291, 294
pictures, 173
ranges, 261
shape formatting, 471, 478
shapes, 471
slides from other presentations, 375
text, 66-67, 401-402
text boxes, 394
worksheet columns/rows, 261
worksheets, 233-235

copyrights, 448
correcting mistakes automatically, 406
Corrections button (Word), 171
COUNT function, 287, 297
COUNTA function, 297
COUNTBLANK function, 297
COUNTIF function, 297
COUNTIFS function, 297, 299
counting entries, 287
counts, viewing with AutoCalculate, 355, 359
Cover Page button (Word), 185
cover pages, 183, 186
Create button (Word), 39
Create Names From Selection dialog box  

(Excel), 283
Create New Building Block dialog box (Word),  

94, 194
Create New Section button (OneNote), 559
Create New Theme Colors dialog box  

(PowerPoint), 426
Create New Theme Fonts dialog box  

(PowerPoint), 426
Create Notebook button (OneNote), 542, 547
crediting pictures, 451
criteria, function, 299
Crop button (Word), 170

cropping pictures, 170
currency, in Excel worksheets, 329, 331
cursor

defined, 596
function of, 38
keyboard shortcuts for, 47, 49
moving, 49-50
paging up or down with, 47
placing, 47
status bar display for, 47

Custom AutoFilter dialog box (Excel), 353
custom slide shows, 596
custom slide sizes, 486
Custom XML Data check box, 506
CUSTOM.DIC dictionary, 412, 415
Customize Quick Access Toolbar button, 33
Customize Ribbon page, 27
Customize Status Bar menu, 8
Cut button (PowerPoint), 401, 404
Cut button (Word), 66, 70, 193
cutting text, 66, 70, 193, 263

vs. copying, 67
keyboard shortcut for, 67, 193, 402

cycle diagrams, 454

D
data bars, 337

defined, 596
gradient fill in, 334
and negative values, 335

data consolidation, 596
data entry

ensuring accuracy of, 361
in multiple cells, 257
techniques, summarized, 257

data entry tools
AutoComplete, 257
AutoFill, 256
AutoFill Options button, 258, 260
Fill Series, 256
overview of, 255
Pick From Drop-Down List, 257, 259

data markers, 463, 596
data points, 463, 596
data series, 463

defined, 596
entering, 256-258
in Excel tables, 276
types of, 257

data source of charts, 596
data types, 348
Data Validation dialog box (Excel), 361, 364
date and time (OneNote), 584
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dates
filtering, 348, 351
in footers, 487
formatting, 329, 330

days, filling cells with series, 258
decimal alignment, 121, 127
Decimal Tab button (Word), 127
Decrease Font Size button (PowerPoint), 438
Decrease Indent button (Word), 120, 129
Decrease List Level button (PowerPoint), 392
defining filter rules, 350
Delete button (Word), 153
Delete dialog box (Excel), 238, 240
Delete key, 64
deleting

background images, 341, 344
building blocks, 185
cells, 238, 240
Clipboard items, 405
columns, 238
conditional formatting rules, 333
custom styles, 317
data, 311
page/section breaks, 214
ranges, 284
rows, 238
sections, 386
slides, 371
tab stops, 122
table rows/columns/cells, 153
text, 64, 66, 68, 71, 403
watches, 303, 307
worksheets, 234, 236

delivering presentations, 495, 512
demoting

outline headings, 596
text, 392

dependents, 302, 596
deselecting

text, 66
text boxes, 395

Design contextual tab, 277
design templates, 596. See also templates 

(OneNote); templates (PowerPoint);  
templates (Word)

destination files, 596, 600
diagrams

adding text, 457
changing colors, 460
creating from bulleted list, 462
cycle, 454
hierarchy, 454, 600
moving, 456, 459
in notes pages, 498
opening Text pane, 458

predefined sets of formatting, 455
process, 454, 603
relationship, 455, 604
sizing, 456, 459
in slides, 455-456
viewing layouts, 459

dialog box launcher, 7, 596
dialog boxes

closing, 12
displaying, 7
displaying errors in, 302
filtering criteria, 349
Help buttons, xxv
moving, 419

dictionaries
adding words to, 269, 272
bilingual, 83, 87
in PowerPoint, 412
supplemental, 412, 415

digital signatures, 596
directory paths, 603
disability accessibility, 503
display effects. See transitions
distributing documents

electronically, 219
in XPS format, 223

dividing cells, 154
dividing presentations into sections, 380
Dock to Desktop button (OneNote), 532
docking OneNote window, 532
docking Side Notes to desktop, 591
document format, setting default, 20
document headings, 51
document history, 16
Document Inspector (PowerPoint), 502, 505
Document Inspector (Word), 219, 221
document navigation, 78
document outlines, 52
Document Panel, 502
document properties, 15, 219-220
Document Properties panel, 229-231
document statistics, 93
document summaries, 221
Document Themes folder, 107
documents. See also saving documents

blank, creating, 41
blank, opening, 38
closing, 48, 51
compatibility with earlier versions, 44
creating, 38-41
default format, setting, 20
formatting in columns, 141. See also columns, 

document
full-screen display, 52, 56
inserting in other documents, 97
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documents (continued)
location, specifying, 23
maximizing, 59
moving to top, 55
navigating, 47, 56-57, 71
opening, 46, 48
printing with default settings, 34
read-only, opening as, 46
recently opened, 16, 46
renaming when saving, 43
repairing, 46
scrolling through, 47, 50
selecting, 65
sharing, 16
side-by-side display, 55
splitting into two panes, 53
switching between, 53, 59
translating, 84
viewing multiple, 59
zooming in/out, 53

Documents library, 46
.docx format, 43-45
dollar sign ($) in absolute references, 294
Draft button, 58
Draft view, 52
drag-and-drop editing, 66, 71, 401
dragging in Excel

to copy formulas, 292
to fill cells, 256
to resize images, 340
to select cells, 260

dragging objects, 597
Draw tab (OneNote ribbon), 520
drawing objects

defined, 597, 600
overview of, 167

drawing pictures in OneNote, 577
drawing shapes in PowerPoint, 470
drawing tables in Word, 151. See also tables
drawing text boxes in Word, 196
Drop Cap dialog box (Word), 202
drop caps

defined, 597
inserting, 202

duplex printing, 217
duplicating shapes, 471, 474
duplicating slides, 375, 378

E
Edit Data button (PowerPoint), 467
Edit Formatting Rule dialog box (Excel), 334-337
Edit Name dialog box (Excel), 284
Edit Shape button (PowerPoint), 476

Effect Options button (PowerPoint), 481
effects. See text effects
Effects button (PowerPoint), 427
effects schemes, 427
efficiency, improving, 6, 227
e-mailing link to OneNote notebook, 546
embedded fonts in Word, 21
embedded objects, 597
Encarta dictionary, 270
encrypting, 597
endnotes, 597
enhanced handouts, 501
entering data series, 256
entering Excel data, 255-256
entering ranges in formulas, 295
entering text, 41, 64

in OneNote, 565, 572
on Outline tab, 390
in Slide pane, 390
in text boxes, 394

equal sign (=) in formulas, 286
erasing slide markup, 511
errata page, xxv
Error button (Excel), 301
Error Checking dialog box (Excel), 302, 305
error codes

#####, 301
common, summarized, 301
#DIV/0!, 301
#NAME?, 301
#REF!, 301
#VALUE!, 301

error messages
adding icons to, 365
Cancel button, 366
displaying default, 366
displaying with validation rules, 363, 364
Retry button, 366

errors, Excel
auditing, 300
changing settings for, 302
deleting, 390
displaying custom messages, 298
displaying in dialog box, 302, 305
finding information about, 301, 305
ignoring, 302
ignoring in AGGREGATE function, 358
messages, 298
reference, 301
settings, changing, 302
tracing dependents to identify, 301
tracing precedents to identify, 301
ways to reduce, 412

errors, spelling, 42, 88-90
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Evaluate Formula dialog box (Excel), 303, 306
examining formulas, 303, 306
Excel 2007

data bars in, 334
icon sets in, 335

Excel 2010
data bars in, 334
ease of use, improving, 227
file formats, 44
icon sets in, 335
online version, xi
program window, customizing, 241
starting, 4, 227, 229
user interface, customizing, 241

Excel, earlier versions of. See also Excel 2007
Paste Options button , 261
pasting in, 261

Excel formats, 229
Excel Options dialog box

Customize The Quick Access Toolbar page,  
244, 251

Customize The Ribbon page, 246, 252
Excel table styles. See table styles
Excel tables

AutoExpansion, 275
columns, adding/removing, 276
converting to range, 277
creating, 275, 277
data, adding, 275, 277
data series in, 276
defined, 597
Design contextual tab, 277
fill color, 324
filtering. See filters
formatting, 322
formulas in, 276, 277, 293
in formulas, 289
names, adding to formulas, 295
overview of, 255
renaming, 276, 278
resize handle, 276
rows, adding/removing, 276
summarizing data in, 276, 277
table style gallery, 275
Total row, 276

Excel workbooks
arranging multiple windows, 243, 251
copying worksheets, 233, 235
creating, 228, 230
default, 228
defined, 608
display font, changing, 313, 315
displaying side by side, 243
Document Properties panel, 229

filtering ranges, 284
properties, 229-232
saving, 229, 232
switching between, 227, 243, 251
themes. See themes, Excel

Excel worksheets
backgrounds, 341-344
columns. See columns, worksheet
copying, 233, 235
creating, 233
defined, 604
deleting, 234, 236
displaying, 233
filtering. See filters
hiding, 234, 235
images, adding, 339, 342
purpose of, 233
renaming, 233, 235
reordering, 234-235
rows. See rows, worksheet
searching, 264
tab color, changing, 234-235
unhiding, 234, 236

exiting. See closing
Expand button (Mini Translator), 87
Expand Navigation Bar button (OneNote), 527
Expand Section button (PowerPoint), 386
Expand The Ribbon button, 8, 33
expanding ribbon, 8, 33
exporting presentations as outlines, 380
Extensible Markup Language (XML), 597
external files, linking in OneNote, 565, 572

F
fancy effects. See WordArt objects
field names, 597
fields, 597
file embedding, 597
file formats

converting, 45
defined, 597
overview of, 44
saving Word documents as, 21
setting default, 20

file information
defined, 603
for documents, 15
for PowerPoint presentations, 502-506
for workbooks, 229-232

file locations of Word documents, specifying, 23
file name extensions, 43-44, 597
File Printout button (OneNote), 565-566, 572
File tab, 6, 15

	 File tab    613



files
inserting in documents, 97
switching between, 53

fill color
adding to cells, 312, 314
adding to Excel table, 324
data bars, 334

Fill Days option, 258
Fill Effects dialog box (Word), 176
fill handle, 256, 597

controlling data series entry, 257
copying formulas with, 292
repeating values with, 257, 259

fill operations, 258
Fill Weekdays option, 258
FillSeries

defined, 257, 597
entering data series, 256

filter arrows, 348, 350-351
filter panel, 349
filtering

defined, 597
OneNote page tabs, 518
ranges, 284

filters, 347-348
active cells in, 349
and AVERAGE function, 355
AutoFilter, 348
clearing, 350, 352-353
creating, 348, 353
and data types, 348
date, 348, 351
defined, 348, 597
filter panel display, 349
for highest or lowest value, 349
labels in, 349
options menu, 348
removing, 350, 352-353
rules, defining, 350
Search box, 349, 352
search filter, defined, 349
and SUBTOTAL function, 357
and SUM function, 355
summarizing data, 355, 357
Top 10 filter, 349
turning off, 350

finalizing
documents, 219, 223
presentations, 503

Find And Replace dialog box, 48, 75, 264, 266
clearing formatting from, 269
Go To tab, displaying, 48
options summarized, 265
Replace tab, displaying, 76

Find button (PowerPoint), 418

Find button (Word), 73, 76
Find dialog box (PowerPoint), 418
Find Format dialog box (Excel), 265, 267
Find text, 420
finding fonts, 420
finding formatting, 130
finding information about errors, 301
finding maximum/minimum value in  

worksheets, 287
finding text, 73, 76, 418. See also Navigation 

task pane
advanced options for, 74, 77
in bilingual dictionary, 83
keyboard shortcut for, 73
matching case when, 75
and replacing, 75, 78
ScreenTips with page numbers for, 74
search direction, specifying, 75
sound-alikes, 75
wildcards in searches, 75

finding worksheet data, 264-266
first line indent, 120, 597
First Line Indent marker, 597
fitting slides to page when printing, 493
flipping shapes, 473
flying onto slide effect, 480
folder paths, 603
folders, creating, when saving documents, 40, 43
followed hyperlink colors, 426
Font box, 438
Font button (Word), 114
Font Color button (PowerPoint), 426, 439-440, 444
Font Color button (Word), 117
Font dialog box (Word), 112, 116
font effects. See text effects
Font gallery, 114
font schemes in PowerPoint, 426, 428
font size

changing, 111, 116, 313
defined, 597
incrementing, 116
keyboard shortcuts for adjusting, 116

Font Size box, 438
font style, 111, 597
fonts. See also character formatting

applying, 115
attributes for, 111
available, 111
changing, 319, 438
color, 111, 117
default, 111
defined, 99, 597
embedding in Word documents, 21
replacing, 418, 420
in themes, changing, 109
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Fonts button (PowerPoint), 428
Fonts gallery (PowerPoint), 426, 428
footers in slides, 487, 598. See also header/footers 

in documents
adding to notes pages, 499
adding to slides, 489
editing before printing, 493
excluding from title slide, 489

footnotes, 598
foreign languages, specifying in Word, 21
Format As Table dialog box (Excel), 275, 277
Format Background dialog box (PowerPoint), 431
Format Cells dialog box (Excel), 312, 316
Format Painter button, 114, 173, 317, 471, 478
Format Shape dialog box, 394
formats

Excel, 229
conditional, 332-338, 596
default, setting, 20
Rich Text Format (RTF), 374, 380, 604

formatting. See also character formatting; fonts; 
themes (Excel); themes (PowerPoint); themes 
(Word)

alignment, 318
automatically, 136
in bold, 18-19, 113, 148, 311, 313, 439
buttons, 311-312
cell, 258, 260, 311
clearing, 269, 311
columns, 140, 312
conditional, 332-338, 596
copying, 173, 317
currency, 329, 331
dates, 329-330
defined, 598
finding/replacing, 130
fonts, 313, 319
with Format Painter, 317
ignoring, in cell copying, 258
inserting and, 237, 239
italics, 314
labels, 309-310
Mini Toolbar, 312
noncontiguous cells, 314
numbers, 319, 327, 329, 331
OneNote notes, 569
pasting and, 263
phone numbers, 328, 331
placeholder backgrounds, 436
previewing, 10
retaining for reused slides , 378
row, changing, 312
searching for, 265, 267
shapes, 471, 478
Special formats, 328

tables, 160
time, in cells, 319
tools for, 311-312

formatting marks
displaying, 56
keyboard shortcut for, 68
section break indicator, 214, 216
showing/hiding, 68, 149

Formula AutoComplete, 288, 295-296, 598
formula bar

changing data in, 266
contents of, 260
defined, 598
Excel display font, changing, 313, 315
hiding, 249

formula box
editing formulas in, 286
phone numbers in, 328

Formula button (Word), 158
Formula dialog box (Word), 158
formulas, Excel

absolute references in, 307
conditional, 296
contiguous cells in, 290
copying and pasting, 291, 294
creating, 286, 288, 295
defined, 286
details, displaying, 303
displaying messages with, 296
editing, 286
entering ranges in, 295
equal sign (=) in, 286
erroneously treated as text, 286
errors. See errors, Excel
examining, 303, 306
Excel tables in, 289, 293, 295
in Excel tables, 276, 277
Formula AutoComplete, 288, 295-296
functions in, 286
ignoring values in, 357
making ranges available for, 282
multiple worksheets and, 243
noncontiguous cells in, 290
ranges in, 282, 288
relative references in, 291, 307
revising, 286
searching in, 266
square brackets in, 289
troubleshooting, 286
unrecognized text in, 301

formulas, Word, 158
constructing, 158
defined, 598
referencing cells in, 158

Forward button, 57

	 Forward button    615



French dictionary, 412
frequently misspelled words, correcting, 88
full name. See user name
Full Page View button (OneNote), 533-534
Full Screen Reading button, 56
Full Screen Reading view, 52, 56
Function Arguments dialog box (Excel), 296-297
functions

adding to formulas, 286
AGGREGATE, 357, 359
arguments, 296
arguments, defined, 288
and AutoCalculate, 355
automatic recalculation of, 354
AVERAGE, 287
AVERAGEIF, 297, 298, 300
AVERAGEIFS, 297, 299
conditional, 297
constructing, 158
COUNT, 287, 297
COUNTA, 297
COUNTBLANK, 297
COUNTIF, 297
COUNTIFS, 297, 299
defined, 286, 598
IF, 296, 360
IFERROR, 297
MAX, 287
MIN, 287
multiple criteria in, 299
NOW(), 287
PMT(), 287
RAND, 354, 360
RANDBETWEEN, 354
SUBTOTAL, 355
SUM, 287, 295
SUMIF, 297
SUMIFS, 297, 299, 300
volatile, 354

funnel icon in filter arrow, 350

G
galleries

building blocks, 595
closing without making selection, 13
defined, 598
of thumbnails, 10

GIF file format, 455
Go To Footer button (Word), 189
Goal Seek, 598
Gradient gallery, 435
grammar checker, 91. See also spelling, checking

graphics. See building blocks; drawing objects; 
images (Excel); images (OneNote); images 
(PowerPoint); images (Word); SmartArt 
graphics

graphics file formats
BMP, 455
GIF, 455
JPEG, 455
PNG, 455
TIFF, 455

grayed-out buttons, 11
grayscale

previewing before printing in, 492
printing in, 493

Grayscale button (PowerPoint), 492
gridlines (Excel), 598
gridlines (OneNote), 571
Group button (PowerPoint), 476
grouping

OneNote sections. See section groups (OneNote)
related data, 282
shapes, 476, 598

groups, ribbon, 7, 598
customizing, 27
removing, 30

Grow Font button (Word), 116

H
handles, 450

adjustment, 595
around shapes, 470
defined, 598
rotating, 604
sizing, 605

Handout masters, 495, 598
handouts

creating in Word, 501
enhanced, 501
printing, 492

handwritten notes (OneNote), 520, 567, 577
hanging indent, 120, 598

adjusting, 126
in columns, adjusting, 145

Hanging Indent marker, 598
Header And Footer dialog box (PowerPoint), 487, 

488, 493, 499
Header button (Word), 188, 216
Header & Footer button (PowerPoint), 488, 499
header/footers in documents. See also footers in 

slides
centering text in, 189
closing, 190, 216
defined, 598
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different first page, 216
editing, 216
hiding, 54
inserting, 188
moving to, 189
navigating between, 188
overview of, 183
settings inheritance, 183, 216

headers, column and row
changing formatting with, 312
displaying unique values, 359, 360
filter arrow in, 351
and SUBTOTAL function, 356

headers, page, 598
headers, slide

adding to notes pages, 499
editing before printing, 493

headings, document, 51
height, row, 237
Help button, xxv, 8, 598
Help, on Office Online Web site, xxvii
Help page (OneNote Backstage view), 525
Help page (Word), 16
Help window

closing, xxviii
displaying, 8
navigating, xxviii
opening, xxvi
printing from, xxix
searching in, xxviii
showing all of topics, xxix
table of contents, displaying, xxvii
topics, displaying, xxvii

help with book, xxv
hidden characters, displaying, 53
hidden formatting marks, displaying, 68
hidden rows, ignoring in AGGREGATE function, 358
hidden text, clearing before distributing 

document, 219
hidden worksheets, displaying, 234, 236
hiding

author names in OneNote, 548
columns, 238, 239
Document Properties panel, 230
formatting marks, 149
formula bar, 249
headers/footers in Word, 54
labels, 249
Mini Toolbar in Word, 18
non-printing characters, 56
ribbon, 59, 249
rows, 238
text, 53
tracer arrows, 302, 305-306
worksheets, 234-235

hierarchy diagrams, 454
highlighting during presentations, 509
highlighting objects. See selecting
highlighting text. See also selecting text

color selection for, 117
removing highlighting, 118

Home tab, 6
Home tab (OneNote), 519
Home tab (Word), 10
horizontal scroll bar, 47
HTML (Hypertext Markup Language), 598, 600
hyperlinks, 426, 598
Hypertext Markup Language (HTML), 598, 600
hyphenating text

defined, 598
in columns, 141, 145

Hyphenation button (Word), 145

I
icon sets

defined, 598
in Excel, 335
rules, changing, 335, 337

IF function, 296-297, 299, 360
IFERROR function, 297
ignoring errors, 302
images (Excel)

attributes, changing, 340
background, 341-344
borders, adding, 340
moving, 343
position, changing, 340
resizing, 340, 343
shape, changing, 340
worksheets, adding to, 339, 342

images (OneNote)
aspect ratio, 595
attaching to files, 575
displaying ScreenTips, 576
inserting, 568, 572-574
opening, 576
resizing, 569
scaling, 568

images (PowerPoint), 448
annotating, 393
crediting, 451
linking for automatic updating, 449
moving, 450
notes pages, adding to, 496
sizing, 450-451
slides, adding to, 448-449
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images (Word)
and line spacing, 169
artistic effects, adding, 173
as backgrounds, 179
brightness, adjusting, 171
contrast, adjusting, 171
copying, 173
correcting, 171
cropping, 170
incomplete display, 169
inserting, 168-169, 173
modifying, 168
overview of, 167
recoloring, 171
resizing, 170
styles, applying, 172
text alignment around, 169
troubleshooting, 169

Important paragraphs, xx
importing outlines, 374
inactive buttons, 11
Increase Font Size button (PowerPoint), 438, 441
Increase Indent button (Word), 120, 126, 133, 148
Increase List Level button (PowerPoint), 392
increasing/decreasing space between letters, 439
indent markers, 120

defined, 599
moving, 126

indenting columns, 145
indenting lists, 132-133
indenting text

first line, 120, 597
hanging indent, 120, 126, 145
left, 120, 126, 600
right, 120, 126

index entry fields, 599
indexes, 599
Info page (OneNote Backstage view), 502, 522
initials. See user name
Insert Above button (Word), 153
Insert Below button (Word), 153, 155
Insert Cells dialog box (Word), 153
Insert Chart button (PowerPoint), 462, 465
Insert Chart dialog box (PowerPoint), 465
Insert dialog box (Excel), 238, 240
Insert Function dialog box (Excel), 276, 286, 296
Insert Left button (Word), 153
Insert Options button (Excel), 237, 239
Insert Outline dialog box (PowerPoint), 375
Insert Picture dialog box (Excel), 339, 342
Insert Picture dialog box (OneNote), 568, 573
Insert Picture dialog box (PowerPoint), 448,  

449, 451
Insert Picture dialog box (Word), 169

Insert Picture From File button (PowerPoint),  
448, 449

Insert Right button (Word), 153
Insert SmartArt Graphic button (PowerPoint),  

455, 456
Insert tab (OneNote), 519
Insert tab (Word), 11
Insert Table dialog box (Word), 150
Insert Table gallery (Word), 150
Insert Worksheet button (Excel), 233
inserting

cells, 238, 240
columns, 237, 239
line breaks, 439
rows, 237, 239
slides, 448
text, 64

inspecting documents, 219, 221, 502, 505
international languages, specifying in Word, 21
Internet Explorer. See Web browsers
Internet links, 426, 600
Italic button (PowerPoint), 440
italicizing text, 314, 439

J
JPEG file format, 455
Justify button (PowerPoint), 438
Justify button (Word), 125, 142
justifying text, 121, 125

in columns, 141, 142
defined, 599
keyboard shortcut for, 121, 142
in PowerPoint, 438

K
Keep On Top button (OneNote), 592
Keep Text Only button (Word), 87
Keyboard Shortcut paragraphs, xx
keyboard shortcuts, 599

for attaching documents, 565
for bolding text, 113
for building blocks, 94
for centering text, 121, 143
for clearing formatting, 118
for copying text, 67
for creating blank OneNote pages, 558
for creating OneNote sections, 559
for creating OneNote subpages, 558, 559
for cursor movement, 47
for cursor placement, 49
for cutting text, 67, 193
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for docking OneNote window, 532
for document navigation, 55, 71, 78
for editing text, 402
for finding text, 73
for Font dialog box display, 116
for font size, 116
for formatting marks, 68
for Go To tab of Find And Replace dialog box, 48
for Help window display, 8
for hiding/displaying rule lines in OneNote, 571
for inserting date and time, 584
for inserting documents in OneNote, 565
for inserting page breaks, 215
for justifying text, 121, 142
for left-aligning text, 121
for line breaks, 121
for minimizing/expanding ribbon, 8
moving cursor with, 47
for navigating OneNote, 534
for OneNote tags, 579
for opening OneNote windows, 518
for opening Side Notes, 591
for outline levels in OneNote, 570
for Page Tabs Bar, 518
for pasting text, 67
for printing, 208
for repeating editing, 67, 146
for replacing text, 76, 130
for Research task pane, 79
for rewinding audio/video notes, 588
for right-aligning text, 121
for saving document, 41
for Screen Clipping tool in OneNote, 581
for selecting all, 65, 142
for underlining text, 113
for undoing editing, 67

keywords, 221, 229, 231
kiosk mode (PowerPoint), 599

L
labels, row and column

in filters, 349
formatting, 309-310
hiding, 249
as range names, 283

Landscape orientation, 208, 599
Language button (PowerPoint), 413
Language dialog box (PowerPoint), 413
languages, specifying additional in Word, 21
languages, translating, 271, 273, 417
launcher, dialog box, 7, 596
Layout button (PowerPoint), 374
Layout dialog box (Word), 200

Layout gallery (PowerPoint), 372
layouts, slide

applying, 374
changing existing slides, 372
diagram, 459
selecting from New Slide gallery, 371

Ledger Paper slide size, 486
left indent

adjusting, 120, 126
defined, 599

Left Indent marker, 599
Left Tab button (Word), 126
left-aligning text, 121
legacy commands, 7, 27
legacy compatibility, 44
legends

in charts, 463
defined, 599

Letter Paper slide size, 486
libraries, slide, 379, 605
Line And Paragraph Spacing button (Word), 122
line breaks

defined, 599
inserting, 120, 125, 439
keyboard shortcut for, 121

line spacing
changing, 438
pictures and, 169

Line Spacing button (PowerPoint), 438, 442
Line Spacing button (Word), 127
lines, selecting, 65, 103
Link button (OneNote), 565
linked objects, 599
linking

defined, 599
to external files in OneNote, 565, 572
text boxes, 196

links, 426, 600
list boxes. See galleries
lists. See also tabbed lists

converting text into, 131-132
ending, 131
indenting, 132-133
modifying, 131
multiple levels, creating, 131, 135
overview of, 130
sorting, 131, 135
undoing formatting of, 131

Live Preview, 10, 424
defined, 599
disabling, 18
Paste, 262
of styles, 316

loan payments, calculating with PMT()  
function, 288
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local OneNote notebooks, 541
locked cells, 599
logon credentials, 599
lowercase. See case

M
machine translator, 84
macros, 599
magnification level, 249

adjusting, 53, 102
displaying multiple pages, 55, 209
to full page, 176
overview of, 242
by percentage, 56
specific zoom level, 242

mail merge, 599
Mailings tab (Word), 14
mailto hyperlinks, 599
main documents, 599
managing ranges, 284
manual page breaks, 599
margins

changing, 206, 208, 211, 216
of columns, 143
defined, 599
gallery of, 209
mirroring, 210
specifying, 119
in tables, 159

Margins button (Word), 12, 119, 216
marking documents as final, 223
marking presentations as final, 503
marking slides, 509
masters

defined, 599
handouts, 495
notes pages, 495, 602

mathematical functions in tables. See formulas, 
Excel; functions

MAX function, 287
Maximize button, 59
maximizing documents, 59
maximum value in worksheets

advantage of identifying, 281
finding, 287

Meeting Properties dialog box (PowerPoint), 505
Merge And Center, 599
Merge Cells button (Word), 153, 155-156
merge fields, 599
Merge List button (Word), 70
merging

bullet points, 71
cells, 153, 155, 599

messages, entry, 363-364
messages, error

adding icons to, 365
displaying custom, 298, 363-364
displaying default, 366
displaying with validation rules, 363-364

microphones, configuring, 585
Microsoft Bing decision engine, 270
Microsoft certification, xii
Microsoft Encarta dictionary, 270
Microsoft Excel 2010

data bars in, 334
ease of use, improving, 227
file formats, 44
icon sets in, 335
online version, xi
program window, customizing, 241
starting, 4, 227, 229
user interface, customizing, 241

Microsoft Knowledge Base, xxix
Microsoft Office 2010

common user interface, 3
compatibility with earlier versions, 44
online applications, xi
software suite comparison, xi
themes in, 322

Microsoft Office Clipboard, 66, 72, 401, 405,  
596, 600

Microsoft Office Compatibility Pack, 45
Microsoft Office Online Web site

clip art images, 448
Help from, xxvii
templates on, 39
themes from, 107

Microsoft Office Specialist (MOS), xii
Microsoft OneNote 2010. See also notebooks 

(OneNote)
advanced options, 536
audio/video options, 536
Backstage view, 522
customizing, 535
display options, 536
docking to desktop, 532-533
docking window, 532
drawing pictures in, 577
entering text in, 572
external files, inserting, 572
file format, 602
Full Page View, 533
handwritten content, 520
Help, accessing, 525
inserting content in, 519
language options, 536
Navigation Bar, 517, 526-527
navigation keyboard shortcuts, 534
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online version, xi
opening images from, 576
Page Tabs Bar, collapsing, 529
Page Tabs Bar, default location of, 526
Pages tab, expanding, 533
page titles, displaying, 529
paragraph formatting, 569
printing from, 525
product activation, 525
program window, 516, 521, 526, 527
proofing options, 536
ribbon, 519, 531
saving options, 536
saving pages, 524
screen clippings from, 579-582
sending items to, 580
sending pages to Outlook/Word, 524
Side Notes, 591
starting, 4, 526
storage structure, 516
tags, 578-579
translating content, 520
undocking, 533
Unfiled Notes section, 528

Microsoft PowerPoint Viewer, 600
Microsoft Product Support Services, xxix
Microsoft SharePoint

file location, setting default, 20
sharing notebooks from, 545, 547

Microsoft Translator service, 84
Microsoft Update service, 10
Microsoft Word 2010. See also documents

compatibility with earlier versions, 44
file formats, 44
first time starting, 10
handouts, creating, 501
Help button, xxvi
Help window, opening, xxvi
OneNote pages, sending to, 524
online version, xi
starting, 4, 10
views in, 52

MIN function, 287
Mini Toolbar, 65, 312, 439, 440

character formatting with, 111
defined, 600
hiding, 18

Mini Translator, 82, 84, 417
Minimize button, 5
Minimize The Ribbon button, 8, 59
minimizing

documents, 5
ribbon, 8, 59

minimum value in worksheets
advantage of identifying, 281
finding, 287

mirroring margins, 210
misspellings. See spelling, checking
mistakes, correcting automatically. See 

AutoCorrect
mobile devices, OneNote on, 593
monitoring values in cells, 303-304
monitors, multiple, 508
months, entering series with AutoFill, 256
More button (PowerPoint), 424
MOS (Microsoft Office Specialist), xii
move handles, 600
Move or Copy dialog box (Excel), 233, 235
Move Up button (Word), 28
moving

cells, 238, 240
to cells, 260
diagrams, 456, 459
dialog boxes, 419
images, 343
pictures, 450
shapes, 471
slides, 384
tables, 152-153
text, 401
text boxes, 394, 397
worksheet columns, 261

Multilevel List button (Word), 131
multi-line text boxes, 393
multiple criteria in functions, 299

N
Name box, creating ranges with, 283, 285
Name Manager dialog box (Excel), 284-285
named ranges. See ranges
naming

documents, 43
OneNote pages/sections, 554-555

narration in slides, turning off, 490
navigating

documents, 71
Help window, xxviii
OneNote, 534
OneNote page tabs, 518
tables, 152

Navigation Bar (OneNote), 517
collapsing, 517
default location of, 526
expanding, 517, 527

Navigation button (OneNote), 510
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Navigation task pane, 77. See also finding text
defined, 600
displaying, 50
editing while open, 74
Search tab, displaying, 73

navigation toolbar, 509-510
nested tables, 600
New Folder button (Word), 40, 43
New Formatting Rule dialog box (Excel), 333, 335
New Name dialog box (Excel), 282, 286
New Page arrow (OneNote), 555, 559
New Page button (OneNote), 557
New page (OneNote Backstage view), 522, 541
New Side Note button (OneNote), 591
New Slide button (PowerPoint), 372-373, 375
New Slide gallery (PowerPoint), 371, 373
New Table Quick Style dialog box (Excel), 322, 323
Next Page button, 47, 50, 56
Next Page button (OneNote), 534
Next Page button (Print Page), 493
Next Slide button (PowerPoint), 497
noncontiguous cells, adding to formulas, 290
nonprinting characters

displaying, 53
keyboard shortcut for, 68
section break indicator, 214, 216
showing/hiding, 56, 68, 149

nonstandard color schemes, 444
Normal button (PowerPoint), 382, 498
Normal view

creating slide sections in, 384
defined, 600
in PowerPoint, 53

Normal View button (OneNote), 533
note containers (OneNote), 564

automatic creation of, 572
contents of, 564
defined, 600
inserting, 564
modifying, 564-565
object selectors for, 564

note separators, 600
notebook headers, 518, 600
notebooks (OneNote), 516. See also pages 

(OneNote); sections (OneNote)
appearance of, 517
authors, 548
backgrounds, changing, 571
backup copies, opening, 522
closing, 518
collaboration on, 543
collapsing, 528
creating, 522, 540-542, 547
e-mailing link to, 546

entering text in, 565
green check mark icon, 550
hierarchy, displaying, 517
images, inserting, 568
local, creating, 541
moving sections, 516
multiple, working with, 518
multiuser, 520
offline copies, 543
opening, 518, 522, 530, 546
organizing, 551
Personal, 516, 526
pinning to Recently Closed list, 530
populating, 540
printing, 525
properties, viewing, 522
red slashed circle icon, 550
saving, 524, 567
screen clippings, 579-582
scrolling pages in, 565
sending Web pages to, 579
settings, 530
setup of, 516
sharing, 520, 523, 540, 544-547
spelling/grammar checks, 520
storing, 540
synchronizing, 543, 549-550
templates, 552
Web sharing, 544, 547
yellow caution triangle icon, 550

Notes masters, 495, 600
notes (OneNote)

audio, 585
clip art, inserting, 569
formatting, 569
handwritten, 577
images, inserting, 568
outline levels, 570
Tablet PC, entering with, 567
video, 585
from Web pages, 579-583

Notes Page button (PowerPoint), 495, 496
Notes Page view (PowerPoint), 53, 494
notes pages (PowerPoint)

adding to slides, 495, 497
adding diagrams, 498
adding headers/footers, 499
adding pictures, 496
handwritten, 567
printing, 492, 499

Notes pane, 600
notes, PowerPoint. See notes pages (PowerPoint)
NOW() function, 287
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numbered lists. See also lists
creating, 131, 133
numbering value, setting, 134
number style, changing, 132
restarting numbering, 133

numbered steps, xx
Numbering button (PowerPoint), 437
Numbering button (Word), 131, 133
numbers. See also values

adding text to values, 329, 332
currency, formatting, 329, 331
dates, formatting, 329, 330
displaying visually, 462
formatting, 319, 327, 329, 331
negative, and data bars, 335
negative, displaying, 329
phone numbers, formatting, 328, 331
specifying in validation rules, 364

O
object commands. See contextual tabs
object selectors (OneNote), 564, 600
objects

embedded, 597
linked, 600

Office 2010
common user interface, 3
compatibility with earlier versions, 44
online applications, xi
software suite comparison, xi
themes in, 322

Office Online Web site
clip art images, 448
Help from, xxvii
templates on, 39
themes from, 107

Office Open XML formats, 44
Office Professional Plus, xi
Office Standard, xi
Office theme, 320
Office Themes

copying worksheets, 234
Office Web Apps, xi
.one format, 600
OneNote 2010. See also notebooks (OneNote)

advanced options, 536
audio/video options, 536
Backstage view, 522
customizing, 535
display options, 536
docking to desktop, 532-533
docking window, 532
drawing pictures in, 577

entering text in, 572
external files, inserting, 572
file format, 600
Full Page View, 533
handwritten content, 520
Help, accessing, 525
inserting content in, 519
language options, 536
Navigation Bar, 517, 526-527
navigation keyboard shortcuts, 534
online version, xi
opening images from, 576
Page Tabs Bar, collapsing, 529
Page Tabs Bar, default location of, 526
page titles, displaying, 529
Pages tab, expanding, 533
paragraph formatting, 569
printing from, 525
product activation, 525
program window, 516, 521, 526, 527
proofing options, 536
ribbon, 519, 531
saving options, 536
saving pages, 524
screen clippings from, 579-582
sending items to, 580
sending pages to Outlook/Word, 524
Side Notes, 591
starting, 4, 526
storage structure, 516
tags, 578-579
translating content, 520
undocking, 533
Unfiled Notes section, 528

OneNote icon, 581
action associated with, changing, 593
activating, 590
missing, 590

OneNote Mobile 2010, 593
OneNote Options dialog box, 535-536, 579, 590
OneNote Web App, 593
online applications, xi
online bilingual dictionary, 83, 87
On-screen Show slide size, 486
Open dialog box, 46, 48
Open Notebook button (OneNote), 518, 526
Open Notebook dialog box (OneNote), 526
Open page (OneNote Backstage view), 522
Open XML formats, 44
opening

diagram Text pane, 458
documents, 46, 48
OneNote notebooks, 518, 522, 526, 530, 546

Options dialog box, 7, 17
order of conditional formatting rules, 333
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order of worksheets, 234-235
organizing OneNote notebooks, 551
orientation, page

changing, 206, 208
defined, 602

orphans
defined, 212, 600
setting options for, 212, 215

Outline button, 57
outline levels, assigning in OneNote, 570
outline, shapes, 435
Outline tab, 392, 600
Outline view (Word), 52
outlines, PowerPoint

exporting presentations as, 380
importing into slides, 375
opening as presentations, 376
printing, 492

outlines, Word, importing to PowerPoint, 374
Outlining tab, 57
Overhead slide size, 486
Overview pane, 600
overwriting documents when saving, 41

P
Package for CD, 600
page borders, applying, 181
Page Borders button (Word), 181
Page Break button (Word), 215
Page Break Preview (Excel), 52
page breaks

deleting, 214
inserting, 212
keyboard shortcut for, 215
manual, 599
soft, 212, 603

Page Color button (Word), 13, 176
page colors (Word), 13
Page Layout tab (Word), 11
Page Layout view (Excel), 52
page length, defining. See margins
Page Number button (Word), 189
page numbers

formatting, 190
inserting, 183, 189

page orientation, changing, 206, 208
Page Setup button (PowerPoint), 487
Page Setup dialog box (PowerPoint), 486-487
Page Setup dialog box (Word), 12, 206, 208
Page Tabs area (OneNote)

color, changing, 571
defined, 602

Page Tabs Bar (OneNote), 518, 554
collapsing, 529
collapsing/expanding, 518
default location of, 526
expanding, 554
keyboard shortcut for, 518

page tabs (OneNote)
filtering, 518
navigating, 518
ScreenTips on, 529
selecting, 529
truncating names on, 529

pages (OneNote)
blank, 551, 558
creating, 552, 555, 558
defined, 600
keyboard shortcuts for creating, 558
naming, 554-555
organizing, 551
subpages, creating, 558-559
templates, applying, 556
titles, entering, 554

pagination, 212, 215
paper size, changing, 206, 208
Paragraph dialog box (PowerPoint), 438, 442
Paragraph dialog box (Word), 212, 214

opening, 123
tab alignment, 122

paragraph formatting (OneNote), 569-570
paragraph formatting (PowerPoint), 437
paragraph formatting (Word)

aligning, 120-122, 125-126
borders, 123-124, 128
defined, 119
shading, 128

paragraph indenting
first line, 120, 597
hanging indent, 120, 126, 145
left, 120, 126, 600
right, 120, 126

paragraph marks, 56. See also non-printing 
characters

paragraph spacing, 122, 127, 148, 438
paragraph styles, 100. See also Quick Styles

defined, 600
finding/replacing, 130

paragraphs
aligning, 121
first letter, formatting, 202
keeping lines together, 215
keeping with next, 212
overview of, 119
selecting, 65, 71
width, defining. See margins

Paste All button (Word), 72
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Paste button (PowerPoint), 401, 404, 466
Paste button (Word), 66, 70
Paste gallery, 261
Paste Live Preview, 261-262
Paste Options button (Excel), 261-262
Paste Options button (PowerPoint), 402
Paste Options button (Word), 67, 600
Paste Special dialog box (Excel), 262
pasting text, 66, 70, 263, 401

from Clipboard, 404-405
in earlier versions of Excel, 261
formulas in cells, 291
keyboard shortcut for, 67, 402
options for, 70
Paste Live Preview, 261
previewing, 261
specialized, 263
undoing, 262
without formatting, 191

paths, 601
pattern, background, 341, 343
Pause button (OneNote), 589
pausing video notes (OneNote), 589
PDF files, 601
Pen button (PowerPoint), 511
pen color, 509
pen tool (OneNote), 567, 577
personal information, clearing before distributing 

document, 219, 222
Personal notebook (OneNote), 516, 526
phone numbers

formatting, 328, 331
troubleshooting, 328

photo albums, 601
photos. See images (Excel); images (OneNote); 

images (PowerPoint); images (Word)
Pick From Drop-Down List

data entry, 257, 259
defined, 257, 601

Picture button (OneNote), 568, 573
Picture button (PowerPoint), 448, 451, 496
Picture button (Word), 168, 169, 
Picture Styles gallery, 172
Picture Tools Format contextual tab, 340
pictures. See images (Excel); images (OneNote); 

images (PowerPoint); images (Word)
pinning OneNote notebooks to Recently Closed 

list, 530
PivotCharts, 601
PivotTable fields, 597
PivotTables, 601
pixels, 601
placeholders in slides, 393

AutoFit settings, 406
content, 448

defined, 601
effects, 436
filling with color, 434
formatting, 434
formatting background, 436
outline, 435
selecting all text in, 441
size/position of, 393
sizing to fit text, 439

Play button (OneNote), 587-589
playing audio notes (OneNote), 588
plot area, 601
plus signs between keys, xx
PMT() function, 287
PNG file format, 455
pointing, 601
points (unit of measure), 436, 601
populating OneNote notebooks, 540
Portrait orientation, 208, 601
Position button (Word), 198
position of placeholders, 393
posts, blog, 601
PowerPoint 2010

file formats, 45
online version, xi
starting, 4

PowerPoint Options dialog box, 407
PowerPoint Viewer, 600
practice files, xxi
precedents, Excel

defined, 301, 601
tracing, to identify errors, 301

preformatted tables. See Quick Tables
preparing presentations for delivery, 491
presentations. See also templates (PowerPoint)

controlling audience view, 508
delivering, 495, 512
displaying properties, 503
dividing into sections, 380
exporting as outlines, 380
highlighting during, 509
looping continuously, 490
marking as final, 503
marking slides during, 509
preparing for delivery, 491
previewing, 495
printing, 492, 495
rearrange, 384
removing ending black screen, 510
removing information from, 502, 506
saving as.rtf file, 380
themes, 423-425
transitions. See transitions
for Web page banners, 488
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Presenter view, 495, 508
previewing

Paste Live Preview, 261
color effects (Word), 13
cut or copied items before pasting, 402
documents, 52, 57, 207-210
OneNote templates, 552
presentations, 491, 495
table styles, 161
Word templates, 39

Previous Page button, 47
Previous Screen button, 57
primary key column, 601
Print button, xxix, 217, 218, 492, 495
Print dialog box (OneNote), 525
Print Layout view, 52, 54, 207
Print page (OneNote Backstage view), 493, 525
Print page (Word Backstage view), 208, 217
Print Preview And Settings dialog box  

(OneNote), 525
Print Preview button (OneNote), 525
print previewing, 52, 57, 207-210
print quality, 493
printers, 217-218
printing

booklets, 208
collating, 217
with default settings, 217, 218
duplex, 217
frames around slides, 493
Help topics, xxix
keyboard shortcut for, 208
number of copies, setting, 218
OneNote items, 525, 580
pages per sheet, setting, 208
presentations, 491-492, 495
from Quick Access Toolbar, 34
settings for, 217
speaker notes, 499
Word documents, 34

process diagrams, 454
product activation (OneNote), 525
product support, xxix
professionally designed color schemes, 426
program icon, 5
program user. See user name
program window

manipulating, 5
minimizing, 5
overview of, 5, 8, 10
resizing, 5
scrolling contents of, 47

program window (Excel)
customizing, 241
maximizing space, 249

programs
closing, 5
previous versions, adding commands from, 7
starting, 4

promoting outline headings, 601
promoting text, 392
proofreading, importance of, 87, 92
properties

defined, 601
for documents, 15
for PowerPoint presentations, 502-506
for workbooks, 229-232

Properties dialog box, 221, 229, 231, 502
protecting documents by marking as final, 223
pull quotes. See quote boxes

Q
queries, 601
Quick Access Toolbar

buttons, adding, 31-32, 244, 251
buttons, positioning, 245
customizing, 5, 32, 521
defined, 601
exporting customizations, 245
improving efficiency with, 6
legacy commands, adding, 7
location, 244
moving, 5
overview of, 3
printing from, 34
removing buttons, 245
resetting, 32-34, 245
specifying for active document, 33

Quick Parts. See building blocks
Quick Parts button (Word), 95, 190, 194
Quick Parts gallery, 194
Quick Print button, 34
Quick Styles, 100. See also style sets

applying, 103-104
changing style set, 100
defined, 601
live preview of, 102

Quick Styles button (Word), 200
Quick Styles gallery, 100

displaying, 103
navigating in, 102

Quick Tables. See also tables, Word
defined, 601
inserting, 164
overview of, 151, 163-164

Quick Tables gallery, 164
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quote boxes
defined, 601
inserting, 191
replacing text in, 191

quotes (quotation marks) in text strings, 330-332

R
RAND function, 354, 360
RANDBETWEEN function, 354
random rows, selecting, 354
random values, generating, 354
ranges

cell, defined, 260, 282, 595, 600, 601
changing definition of, 284
comments, 282
copying, 261
creating, 282-284
deleting, 284
displaying, 283
editing, 284-285
filtering, 284
in formulas, 282, 295
managing, 284
names, in formulas, 283, 288
selecting, 260
setting availability of, 282

Reading View button (PowerPoint), 482, 490
Reading view (PowerPoint), 53
read-only, 503

defined, 601
opening documents as, 46

rearranging
presentations, 384
slides, 386

recalculation time, displaying/updating, 287
Recent page, opening documents from, 46
recent Word documents, displaying, 16
recoloring pictures, 171
Record Audio button (OneNote), 586
Record Video button (OneNote), 588
recording notes. See audio notes (OneNote); video 

notes (OneNote)
records, defined, 601
red wavy lines under words, 42
Redo button, 5, 68, 402, 404
redoing editing, 67, 270, 402
reducing text size using AutoFit, 411
reference marks, 601
reference materials, specifying, 81
references

absolute, 294, 307, 595
cell, defined, 595
errors, 301

relative, 291-294, 307, 604
types of, 294-295

References tab (Word), 14
refreshing, defined, 602
related data, grouping, 282
relationship diagrams, 455
relative references, 307

changing to absolute references, 294, 295
defined, 291, 602
usefulness of, 292

Rename dialog box (Word), 30
Rename Section dialog box (PowerPoint), 382
renaming

Excel tables, 276, 278
sections, 382
tabs, 30
worksheets, 233, 235

repairing documents, 46
Repeat button (Word), 68, 113
Repeat Insertion button (Word), 146
repeating background images, 341, 343
repeating editing, 68, 113, 146
repeating values with fill handle, 257, 259
Replace button (PowerPoint), 418, 420
Replace dialog box (PowerPoint), 418
Replace Font dialog box (PowerPoint), 418, 420
replacing data, 264, 268
replacing fonts, 418
replacing text

keyboard shortcut for, 76, 130
options for, 76
in PowerPoint, 401, 418, 420
in Word, 75, 78

Research button (PowerPoint), 417
Research button (Word), 80
Research Options dialog box (Word), 81
Research task pane, 79, 270, 412, 415, 417

Bing decision engine, 270
Encarta dictionary, 270
keyboard shortcuts for, 79
opening, 81, 86
Thesaurus, 270, 273
translation tools, 271, 273

researching information, 417
resetting

Quick Access Toolbar customization, 34
ribbon customization, 31

resize handle, 276
resizing

images in Excel, 340, 343
images in OneNote, 569, 574
pictures, 170
program window, 5
table elements, 153
tables, 152, 157
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Restore Down/Maximize button, 5
restoring data, 270
retaining formatting for reused slides , 378
Reuse Slides task pane, 376
reusing slides, 375, 378
reversing changes, 402
Review tab (OneNote ribbon), 520
Review tab (Word), 14
revising formulas, 286
revisions, clearing before distributing  

document, 219
Rewind 10 Seconds button (OneNote), 588
rewinding audio notes (OneNote), 588
ribbon

button appearance, xiv
button separators, 32
character formatting with, 112
commands, adding to, 33
commands no longer on, 27
commands on, xiii
customizing, 3, 26-29, 32
decreasing width of, xiv
defined, 602
dynamic nature of, xiv
expanding, 8, 33, 531
exporting customizations, 248
groups, 7
groups, removing, 27-28, 30
hiding and displaying, 249
legacy commands, 27
location of, 5
Main Tabs, 246
minimizing, 8, 59
moving commands on, 28
in OneNote, 519
overview of, xiii, 3
resetting, 31, 245
restoring, 249
tabs, 6, 246-247, 252
tabs, removing, 27-28
Tool Tabs, 246

ribbon tabs, 6
adding groups to, 247
changing groups on, 247
changing order of, 246, 252
customizing, 247, 252
hiding, 246
removing, 27-28
removing groups from, 247

Rich Text Format (RTF)
defined, 602
outlines, importing, 374
saving presentations as, 380

right indent, 120, 126
right-aligning text, 121-122

Right Tab button (Word), 149
ripple slide transition, 479
Rotate button (PowerPoint), 473
rotating effect in slide transitions, 480
rotating handles, 602
rotating shapes, 470, 473
rotating text, 394, 397
row headings, 261, 602
rows, Excel table

adding and removing, 276
creating, 275

rows, Word table
deleting, 153
inserting, 153
resizing, 153
setting properties of, 159

rows, worksheet
changing height, 237
changing multiple, 237
copying, 261
deleting, 238
filtering. See filters
formatting, 312
hidden, and SUM and AVERAGE functions, 355
hidden, in AGGREGATE function, 358
hiding, 238
inserting, 237, 239
labels, as range names, 283
labels, hiding, 249
random, selecting, 354
selecting, 261
unhiding, 238

RTF (Rich Text Format) files
defined, 604
outlines, importing, 374
saving presentations as, 380

rule lines (OneNote), 571
Ruler check box, 450
rulers and gridlines

displaying, 53, 120
hiding, 56
markers on, 120
setting tab stops with, 121

rules
conditional formatting, 332-338, 596
filter, defining, 350

rules, validation
creating, 361
defined, 607
entry messages with, 363, 364
error messages with, 363, 364
and existing data, 362
overview of, 361
requiring numeric values, 362
setting for multiple cells, 362
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specifying minimum and maximum, 364
specifying whole numbers, 364
turning off, 363
validation circles, 362, 366
violations, displaying, 362, 366

running
Excel 2010, 4, 227, 229
OneNote 2010, 4, 526
PowerPoint 2010, 4
programs, 4
Word 2010, 4, 10

running heads, xix

S
sample data, creating with RANDBETWEEN 

function, 354
sample templates, 39
Save As command, 41, 229, 231
Save As dialog box (Excel), 231
Save As dialog box (PowerPoint), 380
Save As dialog box (Word), 39, 42-43
Save As page (OneNote Backstage view), 524
Save As Type arrow (Word), 40
Save button (PowerPoint), 391
Save button (Word), 5, 39, 41-42
Save Current Theme dialog box (Excel), 322, 326
saving conditional formatting rules, 333
saving documents, 39, 42

automatically, 41
creating folders for, 43
as earlier format, 45
folders, creating for, 40
in new location, 40, 43
as new version, 41
keyboard shortcut for, 41
overwriting when, 41

saving OneNote items, 524, 567
saving presentations, 380
saving themes, 107, 109
saving workbooks, 229-232
scaling

OneNote images, 568
printed pages, 208
slides when printing, 493

scenarios, 602
Screen Clipping button (OneNote), 581
screen clippings from OneNote, 579

adding to notebooks, 581
capturing, 581
defined, 602
displaying, 582
options for, 580
sending to new page, 581

Screen Clipping tool, 569, 581
ScreenTips

customizing display of, 7
defined, 602
displaying, xxv, 7, 10, 18
feature descriptions, hiding in, 19
language, specifying, 21
for OneNote images, 576
for search results, 74

scroll bar, navigating with, 47
scrolling pages in OneNote, 565
Search box, filtering and, 349, 352
searching. See also finding text

in audio notes, 585
for clip art images, 452
filters for, 349, 602
in Help window, xxviii
wildcards for, 75, 604
for Word templates, 39
in worksheets, 264-266

section breaks
for columns, 140, 142
defining, 602
deleting, 214
formatting mark for, 214, 216
inserting, 214, 216
overview of, 214

Section button (PowerPoint), 381, 383
section groups (OneNote), 555

adding sections to, 560
creating, 559
defined, 602
opening, 560

section tabs (OneNote), 571
sections (OneNote)

color, changing, 555
creating, 555, 559
defined, 602
grouping. See section groups (OneNote)
keyboard shortcut for creating, 559
naming, 554-555

sections (PowerPoint)
creating in Slide Sorter view, 382
deleting, 386
dividing presentations into, 380, 384
rearranging, 386

sections (Word), changing margins, 208
See Also paragraphs, xx
Select Browse Object button, 48, 50
Select button (PowerPoint), 441
Select button (Word), 142, 153
Select Location In OneNote dialog box, 582-583
Select & Type button (OneNote), 577
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selecting
cells, 260
outline levels in OneNote, 570
ranges, 260
tables, 153
worksheet columns/rows, 261

selecting all, 142
keyboard shortcut for, 65
in placeholders, 441
with Select button, 214

selecting text, 65, 68, 71, 141, 401
by line, 103
deselecting, 66
in tables, 155

selection area, 65, 602
selections, creating ranges from, 283
Send page (OneNote Backstage view), 524
sentences, selecting, 65
series axis, 463, 608
series, data, 463

defined, 596
entering, 256-258
in Excel tables, 276
types of, 257

Set Numbering Value dialog box (Word), 134
SET UP paragraphs, xx
Set Up Show dialog box (PowerPoint), 487,  

490, 508
Set Up Slide Show button (PowerPoint), 490
setting a watch, 303-304
setting up automatic slide shows, 491
setting up presentations, 491
setting workbook properties, 229, 231
SGML, 600
Shading button (tables), 163
shading cells in Excel worksheets, 312, 314,  

324, 334
shading cells in Word tables, 162
shading paragraphs, 128
shadow effect, 439
Shape Effects button (PowerPoint), 436
Shape Fill button (PowerPoint), 434
Shape Outline button (PowerPoint), 435
Shapes button (PowerPoint), 470-471
Shapes gallery (PowerPoint), 471
shapes, PowerPoint

adjusting, 470
connecting, 478, 596
copying, 471, 473
copying formatting, 471, 478
drawing, 470
duplicating, 471, 474
effects, changing, 436
filling with color, 434

flipping, 473
formatting, 434, 471
grouping, 476
moving, 471
outline, changing, 435
rotating, 470, 473
setting default formatting, 471
sizing, 470, 474
text, adding, 471, 474

Share button (OneNote), 546
Share page (OneNote Backstage view), 523
Share tab (OneNote ribbon), 520
Share This Notebook button (OneNote), 544
Shared Notebook Synchronization dialog box 

(OneNote), 549
SharePoint

file location, setting default, 20
sharing notebooks from, 545, 547

sharing OneNote notebooks, 520, 523, 540,  
544, 547

e-mailing link to, 546
from SharePoint, 545, 547
on internal network, 545, 547
on Web, 544, 547

sharing Word documents, 16
sharing workbooks, 602
Sheet Background dialog box (Excel), 341, 343
sheet tabs, 602
shortcut menus, 602
shortcuts. See keyboard shortcuts
Show Hidden Icons button (OneNote), 590
Show/Hide ¶ button (Word), 53, 68, 149
Show Table of Contents button, xxvii
Shrink Font button (Word), 116
shrinking text to fit text box, 395
shutter effect for slide transitions, 479
sidebars, Word

inserting, 192
resizing, 193

Side Notes
docking to desktop, 591
keeping on top, 592
keyboard shortcut for, 591
modifying, 591
opening, 591
resizing, 592

side-by-side page display, 55
single-line text boxes, 393
size of placeholders, 393, 439
size of slides, 486
size of text, 438
sizing charts, 467
sizing diagrams, 456, 459
sizing handles, 602
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sizing pictures, 170, 450-451
sizing shapes, 470, 474
sizing slides, 488
sizing text boxes, 394
Slicers, 602
slide backgrounds

applying, 433
changing , 429, 433
colors, 426
formatting placeholder, 436

slide layouts
applying, 374
changing existing slides, 372
diagram, 459
selecting from New Slide gallery, 371

slide libraries, 379, 602
slide markup

erasing, 511
printing, 493

slide masters, 602
slide numbers in footers, 487
Slide Orientation button (PowerPoint), 488
Slide pane

adding text in, 390
defined, 602

Slide Show button (PowerPoint), 509-510
Slide Show view (PowerPoint), 485, 491
slide shows

looping continuously, 490
starting automatic, 491

slide size, changing, 486
Slide Sorter button (PowerPoint), 381, 482
Slide Sorter view (PowerPoint), 53, 482

creating sections in, 382
rearranging slides in, 385

slide timing, 603
slide transitions

adding to presentations, 479, 483
animating, 481
defined, 607
dynamic content, 480
exciting, 479
removing animation, 481
sounds, adding, 482
subtle, 479
timing, 483
viewing, 482

slides
adding, 371, 374
applying color scheme to selected, 426
changing order within presentations, 386
charts in, 462
clip art images in, 448
copying from other presentations, 375

custom shows, 596
date/time in, 489
deleting, 371, 374
diagrams in, 455-456
displaying full screen, 509
displaying preview, 494
dividing into sections, 384
duplicating, 375, 378
footers, 489
highlighting during presentations, 512
importing outlines, 374, 375
in slide libraries, 379
libraries, 379, 605
masters, 605
moving, 384
notes in. See notes pages (PowerPoint)
number, adding, 489
pictures in. See images (PowerPoint)
previewing, 494
printing, 492
rearranging, 386
rearranging in Slide Sorter view, 385
renaming sections, 382
reusing, 378
saving as pictures, 448
size, changing, 486
sizing, 488
text, adding, 390
timing, 605
titles, 390, 607

Slides tab, 384, 603
SmartArt button (PowerPoint), 455, 497
SmartArt graphics, 454, 603. See also diagrams
SmartArt Styles gallery, 460
smart cut and paste, 69
soft page breaks, 212, 603
software support, xxix
Solver, 603
Sort button (Word), 131, 135, 154
Sort Text dialog box (Word), 137
sorting

defined, 603
lists, 131, 135
tables, 154
text, 137

sounds, associating with slide transitions, 482
source documents, 603
source file, 600
source programs, 603
spaces, automatic insertion of, 69
spacing

character, 439
between columns, 144
paragraph, 122, 127, 148, 438
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Spanish dictionary, 412
sparklines, 603
speaker notes

adding diagrams, 498
adding headers/footers, 499
adding to slides, 495, 497
preparing, 501
printing, 492, 499

Special formats (number), 328
special text. See text effects
Spelling And Grammar dialog box (Word), 88, 91
Spelling button (PowerPoint), 412, 414
spelling, checking, 42, 269, 272, 412, 415, 520

adding new words to dictionary, 269, 272
with AutoCorrect, 88-89
with shortcut menu, 88, 90
with Spelling and Grammar dialog box, 88
turning off, 412
typos, 63

Spelling dialog box (Excel), 272
Spelling & Grammar button (Word), 88, 91
Split Cells button (Word), 154
splitting cells, 154, 603
splitting documents, 53
spreadsheets. See worksheets
square brackets [ ] in formulas, 289, 299
stacking

text, 394
windows, 59

Standard Generalized Markup Language  
(SGML), 600

Start button, 4
Start menu, 4
starting

Excel 2010, 4, 227, 229
OneNote 2010, 4, 526
PowerPoint 2010, 4
programs, 4
Word 2010, 4, 10

statistics, document, 93
status bar

AutoCalculate on, 355
cursor location on, 47
customizing, 8
default items on, 9
defined, 603

Stop button (OneNote), 587, 589
storing OneNote notebooks, 540
strikethrough effect, 439
strings, text, 330-332
Style dialog box (Excel), 316-317
style sets. See also Quick Styles

changing, 100, 104
displaying list of, 101
live preview of, 101

styles, picture, 172
styles, table

adding to Cell Styles gallery, 317
applying, 316, 323
clearing, 323
creating, 316-317, 322-323
default, changing, 323
defined, 606
deleting, 317
overview of, 316
previewing, 161, 316

subentries, index, 603
subpages (OneNote)

collapsing, 559
creating, 558
defined, 603
keyboard shortcut for, 558-559

subpoints, 603
SUBTOTAL function

and column headers, 356
and filters, 357
AVERAGE operation, 356
compared to AGGREGATE, 357
COUNT operation, 356
COUNTA operation, 356
function_num argument, defined, 355
ignoring in AGGREGATE function, 358
introduced, 355
limitations of, 357
MAX operation, 356
MIN operation, 356
operations, summarized, 356
PRODUCT operation, 356
STDEV.P operation, 356
STDEV.S operation, 356
SUM operation, 356
syntax, 355
VAR.P operation, 356
VAR.S operation, 356

SUM function, 287, 295, 355
SUMIF function, 297
SUMIFS function, 297, 299-300
summaries, viewing, 221
summarizing data. See also formulas, Excel; 

functions
with AutoCalculate, 355, 359
in Excel tables, 276, 277

summary formulas and conditional formatting, 336
supplemental dictionaries, 412, 415
switches, 603
Switch Row/Column button (PowerPoint), 469
Switch Windows button (PowerPoint), 425
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switching
documents, 59
effect of, 321
files, 53
presentations, 425
rows/columns in charts, 469
themes
workbooks, 227

Sync Now button (OneNote), 550
synchronizing OneNote notebooks, 543, 549-550
synonyms, 412, 415-416. See also Thesaurus

defined, 79
displaying more, 416
searching for, 79, 85

T
tab bar, 233
tab leaders, 603
tab stops. See also tabbed lists

center-aligned, setting, 148
default, 121
defined, 603
deleting, 122
moving, 122
precisely placing, 122
right-aligned, setting, 149
setting, 121, 122

tabbed lists. See also tab stops
defined, 603
entering text for, 147
formatting text in, 148
overview of, 147
setting up, 147

Table button (Word), 154, 164
table cells

borders, 162
deleting, 153
inserting, 153
merging, 153, 155
setting width of, 159
shading, 162
splitting, 154

table columns
deleting, 153
inserting, 153
resizing, 153
setting width of, 159

Table Properties dialog box (Word), 159
table styles

adding to Cell Styles gallery, 317
applying, 316, 323
clearing, 323
creating, 316-317, 322-323

default, changing, 323
defined, 603
deleting, 317
overview of, 316
previewing, 161, 316

Table Styles gallery, 160-161
tables, Excel

AutoExpansion, 275
columns, adding/removing, 276
converting to range, 277
creating, 275, 277
data, adding, 275, 277
data series in, 276
defined, 597
Design contextual tab, 277
fill color, 324
filtering. See filters
formatting, 322
formulas in, 276, 277, 293
in formulas, 289
names, adding to formulas, 295
overview of, 255
renaming, 276, 278
resize handle, 276
rows, adding/removing, 276
summarizing data in, 276, 277
table style gallery, 275
Total row, 276

tables of authorities, 603
tables of contents

defined, 603
for Help window, xxvii

tables of figures, 603
tables, Word, 139. See also Quick Tables

aligning text in, 156, 163
alt text, entering, 159
banded rows, 161
borders around cells, 162
calculations in, 158
cell width, setting, 159
centering text in, 155
column width, setting, 157, 159
components of, 152
converting to/from regular text, 152, 156
creating, 150, 154
cutting and pasting, 153
defined, 603
deleting rows/columns/cells, 153
drawing, 151
entering text, 152, 155
formatting, 160
formatting text in, 155
headings, rotating, 163
inserting rows/columns/cells, 153, 155-156
margin settings, 159
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tables, Word (continued)
merging cells, 153, 155
move handle, 152, 153, 157
moving, 153
navigating in, 152
overview of, 149
previewing, 154
resizing, 153, 157
row properties, setting, 159
saving as Quick Tables, 165
selecting elements in, 153, 155
shading cells, 162
size handle, 152, 157
sorting, 154
splitting cells, 154
total rows, 161
width, setting, 159

Tablet PC, entering notes with, 567
tablet pens, 603
tabs, 6

customizing, 26
defined, 603
keyboard, 56. See also nonprinting characters
Outline, 392, 602
Overview pane, 392
removing, 27, 28
renaming, 30
Slides, 384, 605

Tag Image File Format (TIFF), 455
tagging documents, 221
tags (OneNote)

applying, 579
defined, 603
keyboard shortcuts for, 579
overview of, 578

technology certification, xii
templates (OneNote)

creating pages from, 552, 556
defined, 603
previewing, 552

Templates task pane (OneNote), 552, 556
templates (Word)

defined, 603
displaying, 16
previewing, 39
recently used, 39
sample, installed with Word, 39
searching for, 39

text
aligning, 438
applying attributes to, 439
capitalization, changing, 439
character spacing, changing, 439
color, changing, 439

deleting, 403
in diagrams, 457
direction, changing, 394
editing, 404
entering, 390
entering/editing in text boxes, 394
finding, 418
finding/replacing, 420
formatting effects, 444
formatting in columns, 140
line spacing, changing, 438
in numbers, 329, 332
outside of placeholders, 393
placeholders for, 393
promoting/demoting, 392
replacing, 418
rotating, 394, 397
selecting all in placeholder, 441
in shapes, 471, 474
shrinking to fit text box, 395
size, changing, 438
sizing to fit placeholder, 406
stacking, 394
in templates, 437
wrapping in text boxes, 395

Text Box button, 393, 396, 451, 474
text boxes, 393

adding borders, 395, 398
adding to slides, 451
changing effect, 436
changing outline, 435
copying, 394
creating, 400
default font,changing, 400
defined, 603
deselecting, 395
drawing, 196
entering/editing text, 394
filling with color, 434
inserting, 191
linking, 196
manipulating, 394
moving, 394, 397
multi-line, 393
overview of, 183
positioning, 196
replacing text in, 191
saving to Quick Parts Gallery, 194
sidebars, inserting, 192
sidebars, resizing, 193
single-line, 393
sizing, 394
wrapping text within, 395

text boxes (OneNote). See note containers 
(OneNote)
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text colors, 426
Text Direction button (Word), 163
text effects

applying, 101, 105, 116
live preview of, 105

Text Effects button (Word), 101, 105
text, entering, 41, 64

in OneNote, 565, 572
on Outline tab, 390
in Slide pane, 390
in text boxes, 394

text, hiding, 53
Text Highlight Color arrow (Word), 34
Text Highlight Color button (Word), 117
Text Pane button (PowerPoint), 457
text, selecting, 65, 68, 71, 141, 401

by line, 103
deselecting, 66
in tables, 155

text size
changing, 111, 116, 313
incrementing, 116
keyboard shortcuts for adjusting, 116

text strings, quotation marks in, 330, 332
text wrapping

defined, 604
in text boxes, 395
around WordArt, 199

textured backgrounds, 178, 430
Theme Colors button (Word), 107
theme colors (Word)

changing, 107, 117
previewing effects of, 13

Theme Fonts button (Word), 108
Themes button (Word), 13, 106-107
themes (Excel)

active, and available colors, 321
applying, 320
changing, 322, 326
colors in palette, 321
creating, 322
default, 320
defined, 320, 604
in other Office programs, 322
Office theme, 320
switching, effect of, 321

Themes gallery, 424
themes (PowerPoint), 423

applying different, 425
live previews of, 424
switching , 424

themes (Word)
applying, 106, 107
color set, changing, 108

font set, changing, 109
from Microsoft Office Online Web site, 107
gallery of, 13
live preview of, 107
mixing and matching, 107
overview of, 106
saving, 107, 109

Thesaurus, 270, 273, 412, 416
finding synonyms in, 85
overview of, 79

Thesaurus button (PowerPoint), 415
Thesaurus button (Word), 79, 85
three-dimensional borders, 128
three-dimensional references, 604
thumb tabs, xix
thumbnails, 384, 605

defined, 604
galleries of, 10

tick-mark labels in charts, 463, 604
TIFF file format, 455
time

in footers, 487
formatting cells for, 319
in OneNote, inserting, 584

time of recalculation, using NOW() function to 
display, 287

timing, slide, 605
Tip paragraphs, xx
title bars, 5, 604
titles

document, 220
slide, 390

Toolbar, Mini, 65, 312, 439, 440
character formatting with, 111
defined, 600
hiding, 18

toolbar, navigation, 509-510
Toolbar, Quick Access

buttons, adding, 31-32, 244, 251
buttons, positioning, 245
customizing, 5, 32, 521
defined, 604
exporting customizations, 245
improving efficiency with, 6
legacy commands, adding, 7
location, 244
moving, 5
overview of, 3
printing from, 34
removing buttons, 245
resetting, 32-34, 245
specifying for active document, 33
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tools, data entry
AutoComplete, 257
AutoFill, 256
AutoFill Options button, 258, 260
FillSeries, 256
overview, 255
Pick From Drop-Down List, 257, 259

tools, formatting. See formatting
tools, research, 270. See also Research task pane
Top 10 AutoFilter dialog box (Excel), 349, 352
Top 10 filter, 349
total rows in tables, 161, 276
totals, viewing with AutoCalculate, 355, 359
tracer arrows, 301-302, 304, 306

defined, 604
hiding, 302, 305-306

tracing dependents to identify errors, 302
tracing precedents to identify errors, 301, 304
transitions

adding to presentations, 479, 483
animating, 481
dynamic content, 480
exciting, 479
removing animation, 481
sounds, adding, 482
subtle, 479
timing, 483
viewing, 482

Translate button (PowerPoint), 417
Translate button (Word), 82, 86
translating text, 271, 273, 417

entire documents, 84
in Excel, 271
in OneNote, 520
options for, 86
in Word, 82, 86

Translation Language Options dialog box  
(Word), 84

transparencies, 486
transposing data in paste operations, 263
trendlines, 604
troubleshooting formulas, 286
Troubleshooting paragraphs, xx
Trust Center dialog box (Word), 25
Trust Center (Word), 24-25
trusted locations, setting, 25
turning effect in slide transitions, 479
two monitors, 508
typos. See spelling, checking

U
UNC addresses, 604
Underline button (Word), 113
underlining text, 113, 439
undo actions, changing default number of, 403
Undo button, 5, 68, 70, 270, 353, 402, 404
undocking OneNote, 533
undoing editing

keyboard shortcut for, 67, 402
procedure for, 68, 70, 270, 402

Unfiled Notes section (OneNote), 528, 604
ungrouping shapes, 478
Unhide dialog box (Excel), 234, 236
unhiding rows/columns, 238
unique values

displaying, 358, 359
and headers, 359, 360

updating charts automatically, 468
updating pictures automatically, 449
uppercase. See case
user input in exercises, xx
user input, validating. See validation rules
user interface. See also ribbon

color scheme, changing, 18
common to Office programs, 3
customizing, 241
elements, navigating, 48

user interface objects in text, xx
user name

AutoText for, changing, 190
common to Office programs, 3
entering, 10
setting, 19

V
validation circles

displaying, 362, 366
hiding, 363, 366

validation rules
creating, 361
defined, 604
entry messages with, 363-364
error messages with, 363-364
and existing data, 362
minimum and maximum, specifying, 364
overview of, 361
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requiring numeric values, 362
setting for multiple cells, 362
turning off, 363
validation circles, 362-363, 366
violations, displaying, 362, 366
whole numbers, specifying, 364

value axes in charts, 463, 608
values. See also numbers

adding together, 286
average, viewing with AutoCalculate, 355, 359
comparing , 334-337
count, viewing with AutoCalculate, 355, 359
filtering for highest or lowest, 349, 353
ignoring in calculations, 357
maximum and minimum, 281, 287
monitoring, 303, 304
replacing, 264
searching for, 264
searching in, 266
sum of, 286
testing, 332-338
total, viewing with AutoCalculate, 355, 359
unique, displaying, 358-359

vertical scroll bar, 47
video notes (OneNote)

appearance of, 586
manipulating video in, 585
pausing, 589
playing, 588
recording, 585, 588
rewinding, 588
searchability, activating, 585

View Ruler button (Word), 120
View Shortcuts toolbar, 9, 52, 604
View Sync Status button (OneNote), 549
View tab (Excel), 242
View tab (OneNote), 521
View tab (Word), 14, 52
Viewer, Microsoft PowerPoint, 600
viewing color schemes, 426
viewing workbook properties, 229
views, Normal

creating slide sections in, 384
defined, 601
in PowerPoint, 53

views, Notes Page, 53, 494, 602
views, Reading, 53, 482, 490
views, Slide Sorter, 53, 482

creating sections in, 382
defined, 605
rearranging slides in, 385

views, Web Layout, 52, 607
visible cells, summarizing, 355, 357
volatile functions, 354

W
watch

defined, 604
deleting, 303, 307
setting, 303-304

Watch Window
defined, 303
deleting a watch, 303, 307
setting a watch, 303, 304

watermarks as background images, 341
Web App (OneNote), 593
Web Apps (Office), xi
Web browsers

defined, 595
previewing documents in, 52, 57

Web Layout button, 57
Web Layout view (Word), 52
Web notes (OneNote), 579

capturing, 583
creating, 583
default location for, 581
options for, 580

Web page banner presentations, 486, 488
Web pages

converting Word documents into, 23
sending to OneNote notebooks, 579

what-if analysis, 604
white space between Word pages, hiding, 54
wide margins, 210, 216
widows

defined, 212, 604
setting options for, 212, 215

width, column, 237
wildcards in searches, 75, 604
Windows Live Translator, 84
Windows logo key, 604
Windows Photo Viewer, 576
windows, stacking, 59
windows, workbook

arranging multiple, 243, 251
cascading, 243, 251

wipe transition effect, 479
Word 97-2003, saving documents as, 21
Word 2010. See also Word documents

compatibility with earlier versions, 44
file formats, 44
first time starting, 10
handouts, creating, 501
Help window, opening, xxvi
OneNote pages, sending to, 524
online version, xi
starting, 4, 10
views in, 52
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word choice, researching, 270
word count, 93
Word Count button (Word), 93
Word Count dialog box (Word), 93
Word documents. See also saving documents

blank, creating, 41
blank, opening, 38
closing, 48, 51
compatibility with earlier versions, 44
creating, 38-41
default format, setting, 20
formatting in columns, 141. See also columns, 

document
full-screen display, 52, 56
inserting in other documents, 97
location, specifying, 23
maximizing, 59
moving to top, 55
navigating, 47, 56-57, 71
opening, 46, 48
printing with default settings, 34
read-only, opening as, 46
recently opened, 16, 46
renaming when saving, 43
repairing, 46
scrolling through, 47, 50
selecting, 65
sharing, 16
side-by-side display, 55
splitting into two panes, 53
switching between, 53, 59
translating, 84
viewing multiple, 59
zooming in/out, 53

Word Help button, 598
Word Options dialog box (Word), 17, 19

AutoRecover settings, 41
Recent page options, changing, 16

Word outlines, importing to PowerPoint, 374
Word tables, 139. See also Quick Tables

aligning text in, 156, 163
alt text, entering, 159
banded rows, 161
borders around cells, 162
calculations in, 158
cell width, setting, 159
centering text in, 155
column width, setting, 157, 159
components of, 152
converting to/from regular text, 152, 156
creating, 150, 154
cutting and pasting, 153
defined, 606
deleting rows/columns/cells, 153
drawing, 151

entering text, 152, 155
formatting, 160
formatting text in, 155
headings, rotating, 163
inserting rows/columns/cells, 153, 155-156
margin settings, 159
merging cells, 153, 155
move handle, 152, 153, 157
moving, 153
navigating in, 152
overview of, 149
previewing, 154
resizing, 153, 157
row properties, setting, 159
saving as Quick Tables, 165
selecting elements in, 153, 155
shading cells, 162
size handle, 152, 157
sorting, 154
splitting cells, 154
total rows, 161
width, setting, 159

word wrap, 604
WordArt button, 198
WordArt objects

centering, 198
converting text into, 197
defined, 604
inserting, 197, 198
overview of, 197
positioning, 198
starting new lines in, 198
styles, applying, 200
text wrapping, 199

words
adding to dictionary, 269, 272
selecting, 65, 68

workbooks
arranging multiple windows, 243, 251
copying worksheets, 233, 235
creating, 228, 230
default, 228
defined, 604
display font, changing, 313, 315
displaying side by side, 243
Document Properties panel, 229
filtering ranges, 284
properties, 229-232
saving, 229, 232
switching between, 227, 243, 251
themes. See themes, Excel

worksheet cells. See also ranges
absolute references, 294, 307, 595
active, 260-261, 349
aligning, 318
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borders, 312, 314
contiguous, in formulas, 290
copying, 258, 261
defined, 596
deleting, 238, 240
deleting contents/formatting of, 311
entering data in, 256, 258
filtering. See filters, Excel
finding sum of, 286
formatting, copying, 258, 260
individual, selecting, 260
inserting, 238, 240
monitoring values in, 303, 304
moving, 238, 240
moving to, 260
noncontiguous, adding to formulas, 290
noncontiguous, formatting, 314
number formatting in, 319
pasting formulas in, 291
references, 294-295, 301, 596
shading, 312-314, 324
splitting, 606
visible, summarizing, 355, 357

worksheet columns
changing multiple, 237
copying, 261
deleting, 238
##### error code, 301
filtering. See filters
formatting, 312
hiding, 238-239
inserting, 237, 239
labels, and filtering, 349
labels, as range names, 283
labels, hiding, 249
moving, 261
selecting, 261
unhiding, 238
width, changing, 237
width errors, 301

worksheets, Excel
backgrounds, 341-344
columns. See columns, worksheet
copying, 233, 235
creating, 233
defined, 604
deleting, 234, 236
displaying, 233
filtering. See filters
hiding, 234, 235
images, adding, 339, 342
purpose of, 233

renaming, 233, 235
reordering, 234-235
rows. See rows, worksheet
searching, 264
tab color, changing, 234-235
unhiding, 234, 236

workspaces, 604
Wrap Text button (Word), 199
wrapping text

defined, 604
in text boxes, 395
around WordArt, 199

X
XML data, removing before distributing  

document, 222
XML (Extensible Markup Language), 597, 604
XML file formats, 44
XPS format

defined, 608
printing documents to, 223

Y
y-axis, 463

Z
zeros in number formatting, 329
Zoom button (Word), 9, 53, 55, 56, 209
Zoom control, 242
Zoom dialog box (Excel), 242, 250
Zoom dialog box (Word), 55, 56, 209
Zoom In button (PowerPoint), 494
Zoom In button (Word), 56
Zoom Level button (Word), 176, 185
Zoom Out button (Word), 56, 102, 191
Zoom Slider, 9, 385
Zoom To Page button (PowerPoint), 494
Zoom To Selection button (Excel), 242, 249
zooming effect in slide transitions, 479
zooming in/out, 249

adjusting, 53, 102
displaying multiple pages, 55, 209
to full page, 176
overview of, 242
by percentage, 56
specific zoom level, 242
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